Setup

This manual supports the following models.

C823n/C823dn
C833n/C833dn
C843n/C843dn
ES8433
ES8443

(O This manual contains cautions on how to use this product safely.
Before you use this product, please make sure that you read this manual.



e About the Product Warranty

Every effort has been made to ensure that the information in this document is complete, accurate,
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its
control. The manufacturer also cannot guarantee that changes in software and equipment made by
other manufacturers and referred to in this guide will not affect the applicability of the information
in it. Mention of software products manufactured by other companies does not necessarily constitute
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness
of the information contained herein.

All rights are reserved by Oki Data Corporation. You must not copy, transfer, translate, etc. the content
herein without authorization. You must obtain written permission from Oki Data Corporation before
doing any of the above.

© 2016 Oki Data Corporation
OKI is a registered trademark of Oki Electric Industry Co., Ltd.
Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft
Corporation.

Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.
Other product names and brand names are registered trademarks or trademarks of their proprietors.

.l As an Energy Star Program Participant, the manufacturer has determined that this product
77 meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 2014/35/
EU (LVD), 1999/5/EC (R&TTE), 2009/125/EC (ErP) and 2011/65/EU (RoHS), as amended where
applicable, on the approximation of the laws of the member states relating to Electromagnetic
Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment, Energy related
Products and Restriction on the use of certain Hazardous Substances in electrical and electronic
equipment.

The following cables were used to evaluate this product to achieve EMC directive
2014/30/EU compliance and configurations other than this may affect that compliance.

cable type ('::&t;) core shield
Power 1.8 X X
usB 5.0 X v
LAN 15.0 X X




e Emergency first aid

Take care with toner powder:
If swallowed, give small amounts of cold water and seek medical attention. DO
NOT attempt to induce vomiting.
If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.

e Manufacturer

Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,

Japan

For all sales, support and general enquiries contact your local distributor.

e Importer to the EU/Authorized representative

OKI Europe Limited

Blays House

Wick Road

Egham

Surrey, TW20 OHJ
United Kingdom

For all sales, support and general enquiries contact your local distributor.

e Environmental information

oM pry,
Z) . /o



www.oki.com/printing/

e For Your Safety

Read the User’s Manual for your safety before using the product.

Cautions related to safety

&WARNING A warning provides additional information which, if ignored, may result in a risk of personal

injury.

/\ CAUTION

General cautions

A caution provides additional information which, if ignored, may result in equipment
malfunction or damage.

/\ WARNING

Do not touch the safety
switch inside the printer.
Doing so may cause electric
shock when high voltage
occurs. In addition, the
rotating gears may result in
injury.

O

®

Do not use highly flammable

sprays near the printer. Doing
SO0 may cause fire as parts of
the printer are hot.

<

Unplug the power cord

and contact a customer
service center if the cover
is unusually hot, smoking,
giving off an unusual odor,
or making strange noises.
Failure to do so may lead to
a fire.

Unplug the power cord and
contact a customer service
center if a liquid such as
water enters in the internal
parts of the printer.

Failure to do so may lead to
a fire.

<

Unplug the power cord and
remove foreign materials
such as paper clips if they
fall inside the printer. Failure
to do so may cause electric
shock and/or fire, leading to
injuries.

Do not operate and/or
disassemble the printer other
than as directed in User’s
Manual. Doing so may cause
electric shock and/or fire,
leading to injuries.

Unplug the power cord

and contact a customer
service center if the printer
is dropped or the cover is
damaged.

Failure to do so may cause
electric shock and/or fire,
leading to injuries.

Unplug the power cord
periodically to clean plug
blades and base section
between the blades.

If the power plug remains
inserted for a long time, the
base section will get dusty,
and the plug may short
circuit, which may cause fire.

Do not clean spilled toner
with a vacuum cleaner.

If cleaning spilled toner with
a vacuum cleaner, it may
catch fire due to the sparks
from electric contact.

Toner spilled on the floor
should be wiped off with wet
cloth.

Do not insert materials in a
vent hole.

Doing so may cause electric
shock and/or fire leading to
personal injuries.

%,

O

Do not put a cup with liquids
such as water on the printer.
Doing so may cause electric
shock and/or fire leading to

personal injuries.

Q)

Do not touch the fuser and
other parts when opening the
cover of the printer.

Doing so may cause burns.

Do not throw toner cartridges
and image drum cartridges
into fire. Doing so may cause
dust explosion leading to
burns.

®

O

Do not use a power cord, a
cable, or a ground wire other
than those that are indicated
in User's Manual.

Doing so may cause fire.

\

The operation of using UPS
(uninterruptible power
source) or inverters is not
guaranteed. Do not use
uninterruptible power source
or inverters.

Doing so may cause fire.

/\ CAUTION

Do not come closer to the paper’s exit area
when the power is turned on, while printing.
Doing so may result in personal injury.

O

Do not touch a damaged liquid-crystal display.

If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush
with large amount of water. Follow the direction
from a doctor if necessary.




e Manual Composition

The following manuals are included with this product.

e Quick Guide
This notes brief descriptions of how to install this printer.

e User’s Manual (Setup) ---- This document

Basic operations are described to aid understanding of this printer. The initial setup descriptions
including printer placement and the network initial setting are noted along with troubleshooting and
maintenance procedures.

e About This Manual

Terms in this document

The following terms are used in this manual.

(! Note)

e Indicates important information on operations. Make sure to read sections with this mark.

e Indicates additional information on operations. You should read sections with this mark.

Reference

e Indicates where to look when you want to know more detailed or related information.

/\ WARNING

e A warning provides additional information which, if ignored, may result in a risk of personal injury.

/\ CAUTION

e A caution provides additional information which, if ignored, may result in equipment malfunction or
damage.

Symbols in this document

The following symbols are used in this manual.

Symbols Description
[ ] e Indicates menu names on the display screen.
e Indicates menu, window, and dialog names on the computer.
e e Indicates messages and input text on the display screen.
e Indicates file names on the computer.
e Indicates reference titles.
< > button/key Indicates a hardware button on the operator panel or a key on the keyboard of the
computer.
> Indicates how to get to the item you want in the menu of this printer or the computer.
Your Printer Indicates a printer you want to use or select.




Notation used in this manual

The following notations may be used in this manual.

e (C823n/C823dn— C823

e (C833n/C833dn— C833

e (C843n/C843dn— C843

e PostScript3 Emulation— PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION

e Microsoft® Windows® 10 64-bit Edition operating system— Windows 10 (64bit version) *

e Microsoft® Windows® 8.1 64-bit Edition operating system— Windows 8.1 (64bit version) *

e Microsoft® Windows® 8 64-bit Edition operating system— Windows 8 (64bit version) *

e Microsoft® Windows® 7 64-bit Edition operating system— Windows 7 (64bit version) *

e Microsoft® Windows Vista® 64-bit Edition operating system— Windows Vista (64bit version) *

e Microsoft® Windows Server® 2012 R2 64-bit Edition operating system— Windows Server 2012 *
e Microsoft® Windows Server® 2012 64-bit Edition operating system— Windows Server 2012 *

e Microsoft® Windows Server® 2008 R2 64-bit Edition operating system— Windows Server 2008 *
e Microsoft® Windows Server® 2008 64-bit Edition operating system— Windows Server 2008 (64bit version) *
e Microsoft® Windows® 10 operating system— Windows 10 *

e Microsoft® Windows® 8.1 operating system— Windows 8.1 *

e Microsoft® Windows® 8 operating system— Windows 8 *

e Microsoft® Windows® 7 operating system— Windows 7 *

e Microsoft® Windows Vista® operating system— Windows Vista *

e Microsoft® Windows Server® 2008 operating system— Windows Server 2008 *

e Generic name for Windows 10, Windows 8.1, Windows 8, Windows Server 2012, Windows 7, Windows Vista, and
Windows Server 2008— Windows

* If there is no special description, 64bit version is included in Windows 10, Windows 8.1, Windows 8, Windows 7,
Windows Vista, and Windows Server 2008. (64bit version and Windows Server 2008 R2 is included in Windows
Server 2008, Windows Server 2012 R2 is included in Windows Server 2012.)

If there is no special description, Windows 7 is used as Windows, Mac OS X 10.11 is used as Mac OS X, and
C833dn is used as the printer for examples in this document.

Depending on your OS, model or version, the description on this document may be different.

The diffusion of dust, ozone, styrene, benzene, TVOC, and ultrafine particles conforms to the Eco Mark
155, “Printer” substance emission certification criteria. (Toner was tested by performing black and
white and color printing with Oki Data genuine toner cartridges according to the appendix S-M of the
Blue Angel RAL UZ-171:2012 test method.)
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1. Setup

How to set up is explained in this chapter.

Setup Flow

1.

Checking Products

Checking package contents

Checking names of the operator panel and how to

operate
Checking names of product parts

Checking options

. Checking the Placement Environment

e Checking the placement environment

Checking placement location

v

. Preparing a Printer

e o0 0 0 0 0 W

Unpacking

Removing cushioning materials
Installing consumables
Loading paper

Turning on/off the power
Installing options

Test printing from the printer

V

. Connecting to a Computer

Connecting through network

Connecting through USB

For Macintosh

For Windows

Connecting through Bonjour

For Windows For Macintosh

v

Specifying an IP address
on the operator panel

|

Connecting a cable

v

Installing a printer driver on a computer

v

M Adding printers on a computer

v

|

Adding printers on a
computer

v

Test printing from a computer

-10 -




Checking Products

e Checking Products

This section gives an overview of the printer.

Checking Package Contents e Software DVD-ROM

Check that you have everything shown below.

ACAUTION It may cause injury! A

e At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

e AC cord
EEReference
° ‘I‘:or details on how to open the package, refer to (, Note)
Unpacking” P.17. e An Ethernet cable and USB cable are not supplied with

your printer. Procure them separately.

e Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

e Printer

e Four image drums (black, yellow, magenta
and cyan)

e Four starter toner cartridges (black, yellow,
magenta and cyan)

(! Note)

e For the C models, the starter toner cartridges are
installed in the image drums, which are installed in
the machine before shipment.

The starter toner cartridge is not installed in the ES
models. Install the toner cartridge that is included in
this machine. Refer to “Replacing the Image Drum”
P.101.

e Quick Guide

-11 -
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Operator Panel

e Operator Panel

This section explains the names and functions of components on the operator panel and how to enter

text.
1 5 2
12 | | I 9
powersave O yewo BAcK @ ENTER @
¢ O
( T (IS
T 1 I | B
13 7 6 5 4 3 10
No. Name Function
1 Display screen Displays operating instructions and the status of the printer.
2 <ON LINE> button Switches between on line and off line modes.
3 <CANCEL> button Cancels the current print immediately.
4 <ENTER> button e Displays the menu screen.
e Confirms the highlighted item.
5 <SCROLL> button Selects the menu or scrolls the screen.
6 <BACK> button Returns to the previous screen.
7 <HELP> button Displays the help screen. To close, press the <HELP> button, <BACK>
button, or <CANCEL> button.
8 <POWER SAVE> button | e Enters or exits the power saving mode.
e Exits the deep sleep mode.
Lights up green in the power save mode and blinks green in the deep sleep mode.
9 Ten-key pad e Enters numbers.
e Enters alphabetical characters and symbols.
A password can be entered only with a ten-key pad.
10 <Fn> key Displays the equipment setting menu screen with a shortcut function.
11 <CLEAR> key Executes the following actions according to the entered items when pressed
or held down.
e Minimizes a setting value.
e Enters zero for a setting value.
e Deletes a character.
e Cancels a selected item.
Returns to the previous settings. Not available when entering an IP address.
12 <READY> indicator Lights up green in on line mode and turns off in off line mode.
13 <ATTENTION> indicator |Lights up or blinks orange when an error occurs in the device.

How to Use the Ten-Key Pad

Use to enter numbers and characters.

Each time a numeric key is pressed, entered
numbers or characters are changed cyclically in

the following order:

<1>:1
<2>:2s5a->b-sc->2
<3>:35d->e>f->53
<4>:4 5g->h->sis4
<5>:55j5k->1-55
<6>:6>mMm->n->0-6
<7>:7->5p->q-or—->s->7
<8>:8-5t->u—->v->8

<9>:9 5W-oX>YyYy>2Z2->9

<0>:0-0

The functions of <> and <C> keys are the
followings:

<¥>: Function key (Available only when the
standby screen is displayed.)

<C>: Deletes a character when entering a
password.

To enter “abc” for example,

press <2> — <2> - <ENTER> button —» <2>
- <2> » <2> - <ENTER> button -» <2> »
<2> 5 <2> —» <2> - <ENTER> button.

-12 -




Operator Panel

How to Use the Function Key Function No. Function menu
26 Other Size (Tray 2)
Press numeric keys after pressing the <Fn> 30 Paper Size (Tray 3)
key when the message “"Ready To Print” 31 X Dimension (Tray 3)
appears on the display screen. The function 32 Y Dimension (Tray 3)
menu corresponding to the number entered is 33 Media Type (Tray 3)
displayed. 34 Media Weight (Tray 3)
35 Legal Paper (Tray 3)
1 Press the <Fn> key. 36 Other Size (Tray 3)
40 Paper Size (Tray 4)
41 X Dimension (Tray 4)
42 Y Dimension (Tray 4)
© 43 Media Type (Tray 4)
44 Media Weight (Tray 4)
45 Legal Paper (Tray 4)
46 Other Size (Tray 4)
2 Press the numeric keys (0-9) to display 80 Paper Feed
the desired function item and press the 90 Paper Size (MP Tray)
<ENTER> button. 91 X Dimension (MP Tray)
92 Y Dimension (MP Tray)
Ry OnLine 93 Media Type (MP Tray)
e @ 94 Media Weight (MP Tray)
@ Cance DE 95 Tray .Usage. (MP Tray)
© 100 Configuration
L CLEAR 101 Network
102 Usage Report
3 The setting screen of the selected 103 Error Log .
. . ;i 200 Power Save Time
function is displayed. Check or change ,
the settings. 201 Sleep Time -
202 Auto Power Off Time
e 210 Error Report
—pppersize YL || Back e 220 Print Position Adjust (MPTray)
* H @ @ 221 Print Position Adjust (Tray 1)
D 222 Print Position Adjust (Tray 2)
222 Print Position Adjust (Tray 3)
223 Print Position Adjust (Tray 4)
. . 230 Paper Black Setting
Function Menu List 231 Paper Color Setting
- 5 232 Trans. Black Setting
Function No. Function menu 233 Trans. Color Setting
1 Private Job 234 SMR Setting
2 Shared Job 235 BG Setting
10 Paper Size (Tray 1) 236 Drum Cleaning
11 X Dimension (Tray 1) 237 Hex Dump
12 Y Dimension (Tray 1) 300 Adjust Density
13 Media Type (Tray 1) 301 Adjust Registration
14 Media Weight (Tray 1) 302 Print Tuning Pattern
15 Legal Paper (Tray 1) 310 Cyan Density
16 Other Size (Tray 1) 311 Magenta Density
20 Paper Size (Tray 2) 312 Yellow Density
21 X Dimension (Tray 2) 313 Black Density
22 Y Dimension (Tray 2)
23 Media Type (Tray 2)
24 Media Weight (Tray 2)
25 Legal Paper (Tray 2)

dmes 1
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Operator Panel

Names of Components

2
S

Name

Front cover

Front cover open lever

Operator panel

Power switch

Output tray

Multipurpose tray

Tray 1

XN | |WIN |

Air vents

No. Name

9 Output tray open button

10 Toner cartridge
Image drum (K: black)

11 Toner cartridge
Image drum (Y: yellow)

12 Toner cartridge
Image drum (M: magenta)

13 Toner cartridge
Image drum (C: cyan)

14 Fuser unit

15 LED head (four heads)

(! Note)

e In the case of the ES models, toner cartridges are not

installed in the Image drums.

No.

16

Multipurpose tray

17 Paper set cover

26 Wireless LAN module cover

No. Name

18 Rear output tray

19 AC power socket

20 Interface part

21 Access cover

22 Duplex unit (Only for the model of the name

with dn or ES)

e Interface part

—

23 > |3
ACC

24 —»(] 8

g

s — ]

o)

LAN O

No. Name
23 Accessory connector

24 USB interface connection

25 Network interface connection




Operator Panel

Available Options

The following options are available for your
printer:

Additional tray unit (tray 2/3/4)
Additional RAM (256 MB or 512 MB)
e 16 GB SD memory card kit
Wireless LAN module

Reference

e For details on how to install the options, refer to
“Installing Options” P.23.

e An SD memory card kit is used for functions such as a
storage for spooling when copying sectors, saving secure
print/encrypted print data, and as a storage destination
for form data. For information on secure print, encrypted
secure print and form data storage functions, please refer
to the User’s Manual (Advanced).

(! Note)

e (823 is available only Tray2.

- 15 -
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Checking the Placement Environment

e Checking the Placement Environment

Placement Environment

Your printer must be placed in the following
environment:

Temperature: 10 - 32°C

o/, - 0]
Humidity: (Zgagtiv?aoh/zriil:lity)
Maximum
wet bulb 25°C
temperature:
Recommended

. 17 - 27°C, 50 - 70 % RH
environment:

(! Note)

e Be careful of condensation. It may cause a malfunction.

e If placing your printer in a location where the humidity of
the surrounding air is less than 30% RH, use a humidifier
or antistatic mat.

/\ WARNING

e Do not install near high temperature or the fire.

e Please do not install in a place from which a
chemical reaction is started (laboratory etc.).

e Do not install near the inflammable solution, such
as alcohol and thinner.

e Do not install in the place which the small child's
hand reaches.

e Do not install in an unstable place (the shaky
stand, leaning place, etc.).

e Do not install in a place many humidity, dusty and
the place where direct rays hit.

e Do not install in the environment of briny air and
corrosive gas.

e Do not install in a place with much vibration.

e Do not install in a place where the ventilation hole
of the printer is closed.

/\ CAUTION

e Do not place directly on a rug or carpet with long
strands.

e Do not install in a closed room with poor
ventilation and circulation.

e If you use the printer in a small room for a long
time, please make sure that you ventilate the
room.

e Install away from strong magnetic fields and
sources of noise.

e Install away from monitors or TVs.

Placement Space

Place your printer on a flat surface that is wide
enough that the printer’s feet securely on the
surface.

Allow for enough room around your printer as
shown in the images below.

e Top view

A
\
\

60 cm A

Y

e Side view

DTS

70 cm

-16 -




Preparing Your Printer

e Preparing Your Printer

This section explains how to unpack your printer and how to turn it on and off.

ACAUTION It may cause injury! A

e At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

(! Note)

Be sure to use the consumables or maintenance units
provided with this printer at first. Otherwise, the life of the
consumables or maintenance units may not be displayed
correctly, or you may not be able to use them later.

The image drum (the green tube) is very delicate. Handle
it carefully.

Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

1 Remove your printer from the box and

remove all cushioning materials and the
plastic bag from your printer.

2 Remove the two strips of protective tape

(1) at the back of your printer.

Installing Consumables

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

C! Note)

e Open the front cover gently. If opening rapidly, an MP
tray may open.

2 Press the output tray open button (3)

and open the output tray (4).

3 Take out all four image drums from the

-17 -
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Preparing Your Printer

4 Remove the protective sheets from four 6 Turn the blue lever (7) of the toner
image drums. cartridge backward until its top aligns on
the ¥ mark.

(1) Place an image drum on a
newspaper. Remove a tape (6) stuck
on a protective sheet (5) and open it.

Turn the levers of all four 4 toner cartridges.

(2) Pull out a protective sheet to the
direction of the arrow.

7 Close the output tray (4) by pushing the
both sides of the cover firmly.

C! Note)
e Do not turn the blue lever of the toner cartridge. 8 Close the front cover (2)
. . ! Not
5 Put all four image drums back into a ) _
. e The front cover cannot be closed securely if the output
prlnter. tray is not closed.

e When the error message that the top or front cover is
open does not disappear from the operator panel’s display
screen, make sure they are closed securely.




Preparing Your Printer

Loading Paper

Reference

e Please refer to “Supported Paper” P.43 for information
on how to load paper into the printer.

1 Pull out the paper tray (1).

2 Set the paper size dial (2) to match the
loading paper size.

Set the dial to [A4 [J] when loading the A4 size
paper with a landscape orientation.

Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

( Note)

e When loading the A6 size paper, move the paper
stopper (4) forward and remove it once, then install
it on the metal part.

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.
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5 Load paper with the print side face down
and press it from above. Turning On/Off the Power
C! Note)

e Do not load paper exceeding the [¥] mark (5) of the Power Supply Conditions
paper guide.

The power supply must meet the following

conditions:

Voltage: 110 - 127 VAC (Range 99 - 140 VAC)
220 - 240 VAC (Range 198 - 264 VAC)

Frequency: 50/60 Hz + 2%

(! Note)
e If the power supply is unstable, use a voltage regulator.
e The maximum power consumption of this printer is

1400 W. Ensure that the power supply is sufficient to
operate this printer.

e We do not guarantee operation where an uninterruptible
power system (UPS) or inverter is used. Do not use an
uninterruptible power system (UPS) or inverter.

6 Secure the loaded paper with the paper

guide. There is a risk of getting
AWARNING an electric shock and/or M
7 Check if a size of loaded paper matches causing fire.
the setting of paper size dial. e Be sure to turn off the power supply switch when
attaching or removing the AC cable and earth wire.
8 Return the paper tray to the printer. e Be sure to connect an earth wire to the grounding
terminal of exclusive use.
e Please do not connect with the ground of a water pipe,
e If loading a paper that you cannot select the a gas pipe, and a telephone wire, and a lightning rod by
size with a paper size dial options, set the dial to any means. _ )
[Other], and then set a paper size on the operator e Make sure to connect with the ground terminal before
panel. connecting the power cord to the power supply plug.

e Be sure to plug in and unplug the AC cable while holding
on to the power supply plug.

e Insert the AC cable plug completely into the wall socket
securely.

e Do not touch the power cord, or printer, if your hands
are wet.

e Install a power cord in the place which is not stepped

on, and do not place a thing on a power cord.

Do not use the cord tied in a bundle.

Please do not use the damaged power cord.

Do not use multi-outlet adapters.

Do not connect this printer and other electric products

to the same wall socket. If it connects simultaneously

with an air conditioner, copier, shredder, etc. Especially,

a printer may incorrect-operate by the electric

noise. When you connect with the same wall socket

unavoidably, please use a commercial noise filter or a

commercial noise cut transformer.

e Use the attached power cord and insert it directory with
the ground terminal. Do not use the power cord for
other product for the printer.

e Do not use an extension cord. When you use it
unavoidably, use the thing more than rated 15 A.

e Use of an extended code may not operate a printer
normally by AC voltage descent.

e During printing, do not shut off a power supply or do not
pull out a power supply plug.

e When you use it neither for consecutive holidays nor a
travel for a long time, pull out a power cord.

e Do not use attached power cord to the other products.
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Turning On the Power

1 Plug the AC cord (1) into the AC power
socket of your printer.

2 Plug the AC cord into the electric socket.

3 Hold down the power switch (2) for
about 1 second to turn on the power.

The Power switch LED indicator lights up when
the printer turns on.

The message “Ready To Print” is displayed in
the operator panel once printer is ready.

Turning Off the Power

1

Hold down the power switch (1) for
about a second.

The message “"Shutting down Please wait.
Printer will turn off automatically” appears
in the operator panel, and the power switch
indicator blinks every 1 second. Then the printer
turns off automatically and the power switch
indicator goes out.

(1t Note)

It may take about 5 minutes to turn off the power. Wait
until it turns off.

Holding down the power switch for more than 5 seconds
turns off printer forcibly. Only perform this procedure
when a problem occurs. For printer problems, refer to
“Other Issues” P.86.

B When the Printer is Not Used for a

Long Time

When the printer is not used for a long time due
to consecutive holidays or when on vacation, or
when changing or attaching parts in repair or
maintenance, unplug the AC cord.

The printer will not be functionally impaired even if left
unplugged for a long time (more than 4 weeks).
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Power Save Mode and Deep Sleep Mode

Two-phase power conservation enables you to
save on power consumed by the printer.

B Power Save Mode

When your printer is not used for a certain
period of time, it automatically enters the power
save mode to reduce the power consumption.

You can enter the power save mode manually
by pressing the <POWER SAVE> button on the
operator panel.

The <POWER SAVE> button lights up green
while in this mode.

READY
POWER SAVE © HELP

ejnle

e By factory default, the time interval before entering the
power save mode is set to 1 minute. For how to change
the time that elapses before the printer enters the power
save mode, refer to “Setting the Time that Elapses Before
Entering the Power Save Mode” P.60.

B Deep Sleep Mode
Your printer goes from the power save mode to
the deep sleep mode after a set period of time.

In the deep sleep mode, the status of your
printer is almost the same as when it is turned
off.

The <POWER SAVE> button blinks while in the
deep sleep mode.

(! Note)

e The printer does not enter the deep sleep mode if an error
occurs.

e By factory default, the time interval before entering the
deep sleep mode is set to 15 minutes. For how to change
the time that elapses before the printer enters the deep
sleep mode, refer to “Setting the Time that Elapses Before
Entering the Deep Sleep Mode” P.61.

Reference

e For more detailed information on deep sleep mode, please
refer to the User’s Manual (Advanced).

B Restoring a Printer from the

Power Saving Mode
To restore the printer from the power save
mode or the deep sleep mode, press the
<POWER SAVE> button on the operator panel.

e When the printer receives a print job from a computer or
other devices, it is restored automatically.

Auto Power Off Function

When a certain period of time elapses after
printing, this printer will turn off automatically.

e The factory default setting for time that elapses before the
printer power turns off automatically is 4 hours.

e For how to change the time that elapses before the
printer power turns off automatically, refer to “Settings for
Turning Power Off Automatically (Auto Power Off)” P.64.

(! Note)

e In the factory default setting, the auto power off mode
is disabled during network connection. To enable the
auto power off mode during network connection, refer to
“Settings for Turning Power Off Automatically (Auto Power
Off)” P.64.
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. . 2 Stack an additional tray aligning a back
Installing Options side of each tray.

This section explains how to install options on
your printer. The following options are available:

Additional tray unit (Tray 2/3/4)
Additional RAM (256 MB or 512 MB)
e 16 GB SD memory card kit

e Wireless LAN module

(! Note)

e Be sure to turn off your printer and unplug the AC cord
and Ethernet or USB cable before installing options.
Installing options while your printer is turned on may
damage your printer and options.

e After installing options, set the option settings with a
printer driver. Refer to "When Adding Options” P.41.

Installing an Additional Tray Unit

Install an optional additional tray unit when 3 Place a printer on the additional trays
you want to increase the paper capacity of your gently aligning the back sides of a
printer. You can install up to three additional tray

units. After installation, you need to configure
the printer driver settings.

N35110A

Reference

e For specifications of the additional tray unit, refer to
“Supported Paper” P.43.

/\CAUTION| It may cause injury! A

e At least two people are needed to lift the printer 4 Plug the AC cord and Ethernet or USB

safely because it weighs about 37 Kg or 40 Kg. cable into your printer, and then turn on
the power switch.

1 Turn off your printer, and then unplug
the AC cord and the Ethernet or USB
cable.

Reference

e "Turning Off the Power” P.21
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e Do not apply force to the printer’s output tray
while it is open.

e Do not apply downward force to the paper tray
while it is pulled out.

e Do not apply force to the printer from the back
while the paper tray is pulled out.

Installing Additional RAM

Install additional RAM to increase the memory
capacity of your printer in cases such as if
memory overflow or the collate print errors
occur. Your printer supports 256 MB and 512 MB
RAM.

(1t Note)

e Use only genuine Oki Data products. The performance
cannot be guaranteed when using other products.

e The static electricity may damage parts. Discharge the
static electricity from your body by touching grounded
metallic parts, etc., before work.

e For banner printing, installing additional memory is
recommended.

1 Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.
EE Reference

e “Turning Off the Power” P.21

2 Open the access cover (1) on the right
side of a printer.
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3 Slide the metal plate (2) upward to
remove.
(! Note)

e If the SD memory card socket is attached, remove
the SD memory card.

(1) Put your finger in the recess of the
metal plate (2), and slide it upward.

(2) Pinch the lower part of the metal
plate (2), and pull it forward.

4 Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it

turns off.
/ )
14
b
7
v
ﬂ‘ﬂ%
5 3
#

5

6

Insert the additional RAM (4) into the
slot and fix it by pushing it toward the
printer.

(1 note)

e Be sure to check a direction of an additional RAM.
The additional RAM has small dents on its connector,
which are fitted with a connector of a slot.

Install the metal plate (2).

(1) First, insert the upper part of the
metal plate (2) in the printer, then
install the metal plate.

(2) While holding the lower part of the
metal plate (2), slide the metal plate
downward and secure it.

(! Note)
e Attach the SD memory card socket before installing
the metal plate if the SD memory card socket was

attached to the printer.
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7 Close the access cover (1). 12 Press the scroll button ¥ several times to
select [RAM] and press the <ENTER>
button.

Cyvetam /2

[ ETotal Memor B
[Fiasn memory
SD Card I

v

13 Check that the value of [RAM] has
increased.

8 Plug the AC cord and Ethernet or USB M
cable into your printer, and then turn on : :

. Total Memory 1/1 BACK 5 ENTER
the power switch. 768MB D

9 Press the scroll button ¥ or A on the D@

operator panel.

Pt ON LINE
Back ENTER - For memory expanded to 256 MB, it is
@ [512 MB]; for memory expanded to 512
CANCEL

D MB, it is [768 MB].
@ aD)

e If the value of [RAM] has not increased, turn off your
printer and unplug the AC cord and Ethernet or USB
cable, and then reinstall the additional RAM.

10 Press the scroll button ¥ to select
[Configuration] and press the 14 Press the <ON LINE> button.

<ENTER> button. w
\. ON LINE p)
@Da

O |o¢

GHI JK

./ MEeNu \.

L 'mn" 1 /?' BACK ENTER
| EConfiguration |
Frire tnoriracion

&{érr\]tu?ecure Job U \ @ CANCEL @
[ ) ( :} PQRS TU
| C

11 Press the scroll button ¥ several times
to select [System] and press the
<ENTER> button.

Configuration 1/1
-Tray Count
ﬁuppliels Life

Atwararls
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Installing the 16-GB SD Memory
Card Kit

For storing print data or a secure printing, install
the SD memory card kit.

SD memory card

SD memory socket

e The SD memory socket is attached to the SD memory
card.

(! Note)

e Use only genuine Oki Data products. The performance
cannot be guaranteed when using other products.

e The static electricity may cause damage to the parts.
Discharge the static electricity in your body by touching
grounded metallic parts, etc. before work.

e You can not use the SD memory card with the protection
switch for accidental overwriting locked. Make sure to
release the lock.

1 Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.

Reference

e “Turning Off the Power” P.21

2 Open the access cover (1).

3 Remove the metal plate (2) by sliding it
upward.

(1) Put your finger in the recess of the
metal plate (2), and slide it upward.

(2) Pinch the lower part of the metal
plate (2), and pull it forward.

4 Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it
turns off.

A
RS
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5

6

7

Install the SD memory card (4) into the

SD memory card socket (5).

Install the SD memory socket to the

printer with the screw (6) and tab (7) for
the SD memory card socket and attach

the connector (8).

Install the metal plate (2).

(1) First, insert the upper part of the
metal plate (2) in the printer, then
install the metal plate.

(2) While holding the lower part of the
metal plate (2), slide the metal plate
downward and secure it.

9 Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.

10 Press the scroll button ¥ or A on the
operator panel.

Menu ON LINE

CANCEL

11 Press the scroll button ¥ to select
[Configuration] and press the
<ENTER> button.

Fiinctinng 1/2

[ EConfiguration ]
Frie anoriauon
£Print Secure Job H

Menus y
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12 Press the scroll button ¥ several times
to select [System] and press the Test Printing from the Printer

<ENTER> button.

Check that you can print with the printer. Check
the detailed settings and status of your printer
by printing the contents of the settings (Menu

Configuration 1/1

ap).
(1t Note)
e When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.
1 Press the <Fn> key on the operator
13 Press the scroll button ¥ several times panel.
to select [SD Card] and press the
ON LINE
<ENTER> button. @

GHI  JKL  MNO

System 2/2

Total Memory |-|
Flach Mamanny

SD Card )
o

v

2 Enter “100” using the ten-key pad and
press the <ENTER> button.

14 Check that the value of [SD Card] is .

./ MEeNU \.

-~ MENu ~.

ON LINE
@

GHI JKL MNO

PQRS TUV  WXYZ

SD Card 1/1 BACK ENTER
15GB[F52] Fn CLEAR
D 3 Press the <ENTER> button as
[Execute] is selected.
(! Note) ./ MEeNu \'
e [15 GB] may be displayed in [SD Card]. This is not an Configuration i/l BAcK ENTER
error.
e If the value of [SD Card] has not increased, turn off @
your printer and unplug the AC cord and Ethernet or USB D
cable, and then reinstall the SD memory card.
15 Press the <ON LINE> button.
ON LiNe @ 4 After finishing a print of printer settings,
AE a setup for printing from a printer
G completes.
Pars U e You can also print reports and lists for each function.
@ Refer to the User’s Manual (Advanced).

dniss 't



dmes ‘1

Connecting to a Computer

e Connecting to a Computer

This section explains how to connect your printer to a computer and install a printer driver software
using the provided “Software DVD-ROM".

Prepare a computer with a DVD drive.

B Connection Method
You can select either of the following connection methods:

e “Network Connection” P.31
e “"USB Connection” P.37

B Product Requirements

Your printer supports the following operating systems:
e Windows 10/Windows 10 (64bit Version)

e Windows 8.1/Windows 8.1 (64bit Version)

e Windows 8/Windows 8 (64bit Version)

e Windows 7/Windows 7 (64bit Version)

e Windows Vista/Windows Vista (64bit Version)

e Windows Server 2012 R2

e Windows Server 2012

e Windows Server 2008 R2

e Windows Server 2008/Windows Server 2008 (x64 Version)
e Mac OS X 10.8.5to 10.11

B Types of Drivers
The types of the drivers that can be installed are as follows.

e For Windows

Type

Description

PCL

The PCL printer driver is suitable for printing of business documents.

PS

The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.

e For Mac OS X

Type Description
PS The PS printer driver can be also used for normal printing. The PS printer driver do not support
C823.
PCL The PCL printer driver can be also used for normal printing. The PCL printer driver support only
C823.
(! Note)

e Depending on the printer driver version or the version of Windows or Mac OS X, the description may be different.

- 30 -
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Network Connection

Perform the following procedure to connect your
printer to a computer via network.

Connecting an Ethernet Cable

Be sure to connect your printer to a network
with an Ethernet cable before driver installation.

1 Prepare an Ethernet cable (1) and a hub
(2).
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

2 Turn off your printer and computer.
EEIReference

e “Turning Off the Power” P.21

3 Plug one end of the Ethernet cable into
the network interface connection (3) on
the back of the printer.

4 Plug the other end of the Ethernet cable
into the hub (2).

Installing a Printer Driver
(for Windows)

To complete the network connection with a
Windows computer, first set IP addresses for the
printer, and then install a printer driver on the
computer.

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or printer.

If your network administrator or internet service
provider specifies an unique IP address for the
computer and your printer, you need to set the
IP addresses manually.

(! Note)
e You need to complete the network setting of the computer
before this procedure.

e To complete this procedure, you must be logged in as an
administrator.

e When setting an IP address manually, ask the network
administrator or your internet service provider which
IP address to use. If the IP address is set wrong, the
network may go down or Internet access may be disabled.

e If configuring a small network consisting of only your
printer and a computer, set IP addresses as shown below
(according to RFC1918).

For the computer
IP address :
Subnet mask :

192.168.0.1 - 254
255.255.255.0

Default gateway : not used
DNS server : not used
For the printer

IP address Set : Manual

192.168.0.1 - 254 (select a

IP address: different value from that of the
computer)

Subnet Mask : 255.255.255.0

Default Gateway : 0.0.0.0

Network Scale : Small

e To set [Network Scale], press the scroll button ¥ or A
and then select [Admin Setup] > [Network Setup] >
[Network Scale].

- 31 -
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QFirst, Set the IP address of the printer.

1
2

4

5

6

Turn on the printer.

Press the <ENTER> button on the
operator panel.

Menu ON LINE

BACK D ENTER
CANCEL

Press the scroll button ¥ to select
[Admin Setup], and press the
<ENTER> button.

Fiinctiong 2/2

£iAdmin Setup i

=Calipration

Enter the administrator password, using
the numeric (0-9) keys.

The factory default password is "999999”. Press
<ENTER> button after each character you input.

Menu ON LINE

Enter Password Back ENTER @ ABC  DEF
' -
‘@

PQRS TUV  WXYZ

CLEAR

Press the <ENTER> button.

Menu ON LINE

BACK D ENTER
CANCEL

Check that [Network Setup] is selected
and press the <ENTER> button.

MEeNu

Admin Satiin 1/4

FrInG Sewup
EPS Setup ”
PCL Setup

BACK

v

7 Press the V¥ to select [IP Address Set],

8

and press the <ENTER> button.

MeNu

Network Setup 2/5
CEthar Tall 0
| FIP Address Set |}
1PV4 AQAress ”
Subnet Mask

If setting the IP address manually, press
the scroll button ¥ and select [Manual],
and press the <ENTER> button.
Proceed to the step 9.

IP Address Set 1/1

Anitn

* Manual

If obtaining the IP address automatically, check
that [Auto] is selected, and press the <ENTER>
button.

Proceed to the step 15.

1P Addrecs Set 1/1

vianuadal

Press the <BACK> button until
[Network Setup] is displayed.
Press the scroll button V¥ to select
[IPv4 Address], and press the
<ENTER> button.

Network Setup 2/5
1D Addracc Cat Ix
[ FIPv4 Address |

Fouullcl. Mask I_
v

Gateway Address
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10 Enter the IP address using the numeric
(0-9) keys, and press the <ENTER>
button.

To move to the next box, press the <ENTER>
button.

- Meny ~. ON Line @

PQRS TUV  WXYZ

__IPvd Address__ || Back — @ =
192. 168. OE D@ @
GHI JKL MNO

‘© D

@O

11 Press the <BACK> button until
[Network Setup] is displayed.
Press the scroll button ¥ to select
[Subnet Mask], and press the
<ENTER> button.

Network Setup 2/5
TDvA Addracc

[ESubnet Mask l

l:uateway Adaress l]
Web U

12 Enter the subnet mask in the same
manner of IP address.

To move to the next box, press the <ENTER>
button.

PQRS TUV  WXYZ

0 ©©

CLEAR

__ Subnet Mask__ ' '
FEBHL. 255. 255, 255 (@)
GHI JKL MNO
@ D®®

13 Press the <BACK> button until
[Network Setup] is displayed.
Press the scroll button ¥ to select
[Gateway Address], and press the
<ENTER> button.

Network Setup 3(5
Ciihnat Macl,
(Gateway Address l

e n
Telnet

v

14 Enter the default gateway address and
press the <ENTER> button.

To move to the next box, press the <ENTER>
button.

After entering all settings, press the <BACK>
button.

Gateway Address

192.168. 0.BEE @

GHI JKL  MNO

D®O®

PQRS TUV  WXYZ

@ O©

15 When the setup menu screen is
displayed, press the <ON LINE> button
to complete the network settings.

NU \. ON LINE @
ENTER

05 O e ol

D CANCEL gu

C
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O Next, install the printer driver on the
computer.

1 Insert the included “Software DVD-ROM”

into a computer.

2 When [AutoPlay] is displayed, click
[Run Setup.exe].

vk AutoPlay

fo] & ==

8 Click [Install Optional Software].

" Setup -nstal Optional Software- =S~
OKI Deice Name'Ca23, Interface Network. o ] Users banual

1. Install Optional Software

1. Install Optional Software > 2. Device Settings > 3. Complete

[ vl Optionst e ] —

@ cosommsan

DVD Drive (E:) OKI
OKI

(| Always do this for software and games:

Intertace Selection

Device Selection

Install or run program from your media

OKI Run Setup.exe

Published by Oki Data Corporation

General options

Open folder to view files

using Windows Explorer

View more AutoPlay options in Control Panel

e If the [User Account Control] dialog box is
displayed, click [Yes].

3 Select a language from the drop-down
list.

4 Read the license agreement, and then
click [Accept].

5 Read [Environment advice], and then
click [Next].

6 Select [Network (Wired/Wireless)]
in accordance to the connection method
of the machine and computer, and then
click [Next].

7 Select the model name of the machine,

and then click [Next].

Installation starts.

e The following software is installed.
- PCL6 Printer Driver
e Install other software from Custom Install

9 Make sure that the software is
successfully installed, and then click
[Printing Test].

10 Click [Complete].

" Setup -nstall Optional Software- =)o

O 0o e tenon 0 o] Users anual

Install Optional Software

Software Staws Instataton progress

\

2
&/ Printing Test

l Complete. I

11 Click [Next].

Tom Setup -Device Configuration- =e e
O oo e et s & e

2. Device Settings

1. Install Optional Scfware > 2. Device Settings > 3. Complete

Wan eny

[)&  mmmrsmssonss
BT

Setthe basictems needed fr the device.




Connecting to a Computer

12 Click [Exit].

O e v © @

mplete

AL,
[ PrintMenu Map
=]

@ Customer Registration

- =

Installing a Printer Driver
(For Mac OS X)

To complete the network connection with a Mac
operating system, install a printer driver on the
computer and set your printer as a network
printer.

(1 Note)

e Disable the anti-virus software before starting this
procedure.

m Install the Mac OS X PS printer
driver. (Except C823)

When the installation is complete, print a test
page in step 14.

1 Make sure that the machine and a
computer are connected and the
machine is turned on.

2 Insert the “Software DVD-ROM” into a
computer.

3 Double-click the [OKI] icon on the
desktop.

4 [Drivers] > [PS] > Double-click
[Installer for OSX].

5 Enter the administrator password, and
then click [OK].

Follow the on-screen instructions to complete the
installation.

6 Select [System Preferences] from the
Apple menu.

7 Click [Printers & Scanners].

8 Click [+].

O

9 Click [Default].

10 Select the machine where [Kind] is
[Bonjour], and then make sure that
[OKI C833 PS] is displayed for [Print
Using].

Connection Priner Name Kind
Network OKI-C833 (last 6 digits of Bonjour
MAC address)
uUsB OKI DATA CORP C833 USB
e To change the name, enter a new name into
[Name:].
( )

11 Click [Add].

12 When [Installable options] is
displayed, click [Continue].

- 35 -
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13 Make sure that the machine is added
to [Printers] and [OKI C833 PS] is
displayed for [Kind].

)

(! Note)
e If [OKI C833 PS] is not displayed for [Kind]
correctly, click [-], delete the machine from

[Printers], and then newly perform steps 8 to 12.

14 Click [Open Print Queue...].

15 Select [Print Test Page] from the
[Printers] menu.

m Install the Mac OS X PCL printer

driver. (C823 only)

When the installation is complete, print a test
page in step 14.

1

9

Make sure that the machine and a
computer are connected and the
machine is turned on.

Insert the “Software DVD-ROM” into a
computer.

Double-click the [OKI] icon on the
desktop.

[Drivers] > [PCL] > [C823] > Double-
click [Installer for OSX].

Enter the administrator password, and
then click [OK].

Follow the on-screen instructions to complete the
installation.

Select [System Preferences] from the
Apple menu.

Click [Printers & Scanners].

Click [+].

O

Click [Default].

10 Select the machine where [Kind] is

[Bonjour], and then make sure that
[OKI C823 PCL] is displayed for [Print
Using].

Types of Displayed in the Methods
Names Connection List
Network OKI-C823 (last 6 digits of Bonjour
MAC address)
uUsB OKI DATA CORP C823 usB
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11
12

13

14
15

e To change the name, enter a new name into
[Name:].

Click [Add].

When [Installable options] is
displayed, click [Continue].

Make sure that the machine is added
to [Printers] and [OKI C823 PCL] is
displayed for [Kind].

)

(! Note)
e If [OKI C823 PCL] is not displayed for [Kind]
correctly, click [-], delete the machine from

[Printers], and then newly perform steps 8 to 12.

Click [Open Print Queue...].

Select [Print Test Page] from the
[Printers] menu.

USB Connection

Perform the following procedure to connect your
printer to a computer via USB.

Connecting a USB Cable

1

Prepare a USB cable (1).

A USB cable is not supplied with your printer.
Prepare a USB 2.0 cable separately.

e Use a USB 2.0 Hi-Speed cable for a USB 2.0 Hi-
Speed connection.

Turn off your printer and the computer.

Reference

e “Turning Off the Power” P.21

Plug one end of the USB cable into the
USB interface connector (2) on the back
of the printer.

Plug the other end of the USB cable into
the computer’s USB interface connector.

/SQQQQ

Y
i)

(1t Note)

e Do not plug the USB cable into the network interface

connection. Doing so may cause a malfunction.

dniss 't
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Connecting to a Computer

Installing a Printer Driver
(For Windows)

(1t Note)

e You must be logged in as an administrator to complete

1

2

~

this procedure.

Insert the included “Software DVD-ROM”

into a computer.

When [AutoPlay] is displayed, click
[Run Setup.exe].

fol & =]

vt AutoPlay

DVD Drive (E:) OKI
OKI

|| Always do this for software and games:

Install or run program from your media

OKI Run Setup.exe

Published by Oki Data Corporation

General options

Open folder to view files

sing Windows Explorer

View more AutoPlay options in Control Panel

e If the [User Account Control] dialog box is
displayed, click [Yes].

Select a language from the drop-down list.

Read the license agreement, and then
click [Accept].

Read [Environment advice], and then
click [Next].

Select [USB] in accordance to the
connection method of the machine and
computer, and then click [Next].

Select the model name of the machine,
and then click [Next].

8 Click [Install Optional Software].
" Setup -Install Optional Software- =e
OKI ikl (i} Hep. m Users Manual

1. Install Optional Software

1. Install Optional Software > 2. Device Settings > 3. Complete.

[@.m..w.. e ]

@ Comom s

Intertace Selection Device Selection Next

Installation starts.
e The following software is installed.
- PCL6 Printer Driver
e Install other software from Custom Install.

9 Make sure that the software is

successfully installed, and then click
[Printing Test].

10 Click [Complete].

T Setup -Instal Optional Software- =le
QI oo netetss oscon o @
Install Optional Software

A,
‘Q" Printing Test
l Compiets I
=Setup Device Confguraion- (=1
QK Coormem mms oo — =l
2. Device Settings
1. Instal Optonal Software > 2. Device Settings > 3. Compiete
o er
[T] 8 rommsmrassvrsaonss e
@
fr R —




Connecting to a Computer

12 Click [Exit]. 8 Click [+].
P — P — —
Print Menu Map
@ Customer Registration O
= ) 9 Click [Default].
Installing a Printer Driver 10 Select the machine where [Kind] is
(For Mac OS X) [USB], and then make sure that [OKI
s C833 PS] is displayed for [Print
(. Note) Usin ]
e Disable the anti-virus software before starting this gl
procedure.
Connection Priner Name Kind
m Install the Mac OS X PS printer Network OKI-C833 (last 6 digits of Bonjour
. MAC address)
driver. (Except C823) usB OKI DATA CORP C833 usB
When the installation is complete, print a test
page in step 14.
. e To change the name, enter a new name into
1 Make sure that the machine and a [Name:].
computer are connected and the
machine is turned on.
2 Insert the “Software DVD-ROM” into a
computer.
3 Double-click the [OKI] icon on the
desktop.
4 [Drivers] > [PS] > Double-click [ )
[Installer for OSX].
5 Enter the administrator password, and
then click [OK].
Follow the on-screen instructions to complete the 11 Click [Add]

installation.

12 When [Installable options] is

6 Select [System Preferences] from the displayed, click [Continue]

Apple menu.

7 Click [Printers & Scanners].
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13 Make sure that the machine is added
to [Printers] and [OKI C833 PS] is
displayed for [Kind].

)

| G
(! Note)
e If [OKI C833 PS] is not displayed for [Kind]
correctly, click [-], delete the machine from

[Printers], and then newly perform steps 8 to 12.

14 Click [Open Print Queue...].

15 Select [Print Test Page] from the
[Printers] menu.

m Install the Mac OS X PCL printer
driver. (C823 only)

When the installation is complete, print a test
page in step 14.

1

Make sure that the machine and a
computer are connected and the
machine is turned on.

2 Insert the “Software DVD-ROM” into a
computer.

3 Double-click the [OKI] icon on the
desktop.

4 [Drivers] > [PCL] > [C823] > Double-
click [Installer for OSX].

5 Enter the administrator password, and
then click [OK].

Follow the on-screen instructions to complete the
installation.

6 Select [System Preferences] from the
Apple menu.

7 Click [Printers & Scanners].

8 Click [+].

@

9 Click [Default].

10 Select the machine where [Kind] is
[USB], and then make sure that [OKI
C823 PCL] is displayed for [Print
Using].

Types of Displayed in the Methods
Names Connection List
Network OKI-C823 (last 6 digits of Bonjour

MAC address)
usB OKI DATA CORP C823 usB




Connecting to a Computer

11
12

13

14
15

e To change the name, enter a new name into
[Name:].

Click [Add].

When [Installable options] is
displayed, click [Continue].

Make sure that the machine is added
to [Printers] and [OKI C823 PCL] is
displayed for [Kind].

)

(! Note)
e If [OKI C823 PCL] is not displayed for [Kind]

correctly, click [-], delete the machine from
[Printers], and then newly perform steps 8 to 12.

Click [Open Print Queue...].

Select [Print Test Page] from the
[Printers] menu.

When Adding Options

If options such as additional tray unit and/or
SD memory card kit have been installed, use
following procedures to change printer driver
settings.

B For Windows PCL Driver

1
2

5

Click [Start] > [Devices and Printers].

Right-click the [OKI C833] icon and
select [Printer Properties]. (If you
have installed multiple printer drivers,
select [Printer Properties] >[OKI
C833 PCL6].)

Select the [Device Options] tab.

If using a network connection, select
[Get Printer Settings].

If using a USB connection,

enter the total number of trays
excluding the multipurpose tray in
[Installed Paper Trays]. For example,
when three option trays are installed,
enter “4” as the trays 1, 2, 3 and 4 are
available.

(=) OKI C832 PCL6 Propertics ==

[ Geneml Shaing | Pots | Advanced | Color Management
[ Status | Securty. | Device Options

Installed Options - .

|| Duplex Unit
[0 Memory Card:
Jobtypes to print

o jol

@ Print any job types
() Only allow Private Print jobs

Click [OK].
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B For Windows PS Driver 5

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI C833] icon and
then select [Printer Properties]. (If
you have installed multiple printer
drivers, select [Printer Properties] >
[OKI C833 PS].)

3 Select the [Device Settings] tab.

4 If using a network connection, select
[Get installed options automatically]
under [Installable Options], and then
click [Setup].

If using a USB connection, select

an appropriate number of trays in
[Available Trays] under [Installable
Options].

(5 OKI 833 PS Properties. ==

| General | Sharing | Pots | Advanced | Color Managem ert
Status Secwty | Device Settngs

5 Click [OK].

B For Mac OS X Driver

1 Select [System Preferences] from the
Apple menu.

2 Click [Printers & Scanners].

3 Select the name of your printer and then
click [Options & Supplies].

4 Select the [Options] tab.

Select the number of available trays in
[Available Tray], and then click [OK].



2. Printing Basic Operation

This chapter describes how to print documents from a computer.

e Supported Paper

Supported Paper Types

For high-quality printing, be sure to use paper types that satisfy requirements such as those for
material quality, weight, and surface finish. Please use digital photo print paper.

If not using recommended paper, please check the print quality and the movement of the paper
sufficiently beforehand to make sure that there are no problems. Your printer supports the following

types of paper.

Paper Type Paper Size mm (inch) Paper Weight
Plain paper A3 297 x 420 64 to 256 g/m?
A4 210 x 297 For duplex print, 64 to 220 g/m?
AS 148 x 210 (note)
A6 105 x 148 e If the paper size is set at A6, A5, or
o1 i o 148
B5 182 x 257 slower.
B6 128 x 182
B6 Half 64 x 182
Tabloid (11 x17)
Letter 215.9 x 279.4
(8.5x11)
Legal 13" 215.9 x 330.2
(8.5 x 13)
Legal 13.5" 215.9 x 342.9
(8.5 x 13.5)
Legal 14" 215.9 x 355.6
(8.5 x 14)
Executive 184.2 x 266.7
(7.25 x 10.5)
Statement (5.5 x 8.5)
8.5"SQ (8.5 x 8.5)
Folio 210 x 330.2
8K (260 x 368 mm) 260 x 368
8K (270 x 390 mm) 270 x 390
8K (273 x 394 mm) 273 x 394
16K (184 x 260 mm) 184 x 260
16K (195 x 270 mm) 195 x 270
16K (197 x 273 mm) 197 x 273
Custom Size Width: 64 to 256 g/m?
64 - 297
Length:
90 - 1321

-43 -
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Supported Paper

Paper Type Paper Size mm (inch) Paper Weight
Envelope Nagagata #3 120 x 235 Envelopes should be 24Ib paper, and
Nagagata #4 90 x 205 flap parts of envelopes should be folded.
Nagagata #40 90 x 225
Youkei #0 120 x 235
Youkei #4 105 x 235
Kakugata #2 240 x 332
Kakugata #3 216 x 277
C4 229 x 324
C5 162 x 229
DL 110 x 220
Com-10 104.8 x 241.3
Index card Index card 76.2 x 127
(3x5)
Photo Photo (4 x 6 inch) (4 x 6)
Photo (5 x 7 inch) (5x7)
Hagaki Hagaki 100 x 148
Oufuku Hagaki Oufuku Hagaki 148 x 200

Use paper that meets the following conditions*":

e Paper that meets the conditions for plain paper.

e An ink used for a part printing is heat resistant (230°C).

(1 Note)

e When specifying a printing area, please take into account the differences of printing position as followings:
Print start position: £2 mm, Paper skew: £1 mm/100 mm, Image stretch: £1 mm/100 mm
(when paper ream weight is 70 kg)

e This printer cannot print on an ink.

Use paper that meets the following conditions*?:

e A pigment or an ink used to color paper is heat resistant (230°C).

e Paper that has same characteristics with light paper and used for an electronic photo printer.

Paper Recommendations

Your printer will handle a variety of print media,
including a range of paper weights and sizes.

This section provides general advice on choice of
media, and explains how to use each type.

The best performance will be obtained when
using standard 75 - 90 g/m? paper designed for

use in copiers and laser printers.

Use of heavily embossed or very rough textured

paper is not recommended.

/\ CAUTION

Envelopes should be free from twist, curl or

other deformations. They should also be of the
rectangular flap type, with glue that remains
intact when subjected to hot roll pressure fusing
used in this type of printer. Window envelopes are
not suitable.

Labels should also be of the type recommended
for use in copiers and laser printers, in which the
base carrier page is entirely covered by labels.
Other types of label stock may damage the printer
due to the labels peeling off during the printing
process.

Pre-printed stationery can be used, but the ink

must not offset when exposed to the high fuser

temperatures used in the printing process.
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Supported Paper

Storing Paper

Store paper under the following conditions to
maintain quality.

Inside a cabinet or other dry and dark place

On a flat surface

Temperature: 20°C
Humidity: 50% RH (relative humidity)

Do not store in the following locations.

e Directly on the floor

e In direct sunlight

e Near the inside of an exterior wall

e On an uneven surface

e Where static electricity may be generated

e In places that are excessively hot or where
temperature rapidly changes

(! Note)

Do not unwrap the paper until you are ready to use the
paper.

e Do not leave paper unwrapped for a long period. Doing
so may result in paper handling and print quality issues.

e Depending on a media you use, usage conditions and a

storing conditions, a decrease in paper quality or curling

of the paper may occur.

Near a copier, air conditioner, heater, or duct
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Supported Paper

Paper Loaded on the Tray

Your printer has two built-in trays (tray 1 and the MP tray) and an additional tray unit (tray 2/3/4).
Refer to the list below to check the supported paper and capacities of each tray.

(! Note)
e Duplex printing can not be performed on paper indicated with an asterisk (*).
Tray Supported paper size Paper capacity Paper weight

Trayl A3 300 sheets e Light
A4 (when paper weight is 80 g/m?) (64 to 82 g/m?)
A5 e Medium Light
A6 (83 to 90 g/m?)
Eg e Medium
BG* (91 to 105 g/m?)
Tabloid e Heavy ,
Letter (106 to 128 g/m?)
Legal 13” e Ultra Heavyl
Legal 13.5" (129 to 188 g/m?)
Legal 14” e Ultra Heavy2
Executive (189 to 220 g/m2)
Statement*
8.5"SQ
Folio
8K (260 x 368 mm)
8K (270 x 390 mm)
8K (273 x 394 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Custom Size

Tray2/3/4 A3 530 sheets e Light

(option) A4 (when paper weight is 80 g/m?) (64 to 82 g/m?)

A5

B4

B5

Tabloid

Letter

Legal 13"

Legal 13.5"

Legal 14”

Executive

8.5"SQ

Folio

8K (260 x 368 mm)
8K (270 x 390 mm)
8K (273 x 394 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Custom Size

e Medium Light
(83 to 90 g/m?)
e Medium
(91 to 105 g/m?)
e Heavy
(106 to 128 g/m?)
e Ultra Heavyl
(129 to 188 g/m?)

(! Note)

e Weight of paper loaded on an
additional tray unit is 64 to
176 g/m?.

e The specified paper weight
of Ultra Heavy1 is described
as 129 to 188 g/mz, but the
printable weight is up to
176 g/m?.
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Supported Paper

Tray Supported paper size Paper capacity Paper weight

MP Tray A3 e 100 sheets e Light
A4 (when paper weight is 80 g/m?)| (64 to 82 g/m?)
A5 e 10 envelopes e Medium Light
A6 (83 to 90 g/m?)
2‘5‘ e Medium
BG* (91 to 105 g/m?)
B6 Half* e Heavy
Tabloid (106 to 128 g/m?)
Letter e Ultra Heavyl
Legal 13" (129 to 188 g/m?)
Legal 13.5" e Ultra Heavy2
Legal 14" (189 to 220 g/m?)
Executive e Ultra Heavy3
Statement* (221 to 256 g/m?)

8.5"SQ

Folio

8K (260 x 368 mm)

8K (270 x 390 mm)

8K (273 x 394 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Index Card*

Photo (4 x 6 inch)
Photo (5 x 7 inch)
Custom Size

Envelope Nagagata #3*
Envelope Nagagata #4*
Envelope Nagagata #40%*
Envelope Yougata #0*
Envelope Yougata #4*
Envelope Kakugata #2*
Envelope Kakugata #3*
C4*

C5*

DL*

Com-10%*

Postcard*

Double Postcard*

-47 -
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How to Print from the Tray

e How to Print from the Tray

The following procedure explains how to load paper in tray 1 or tray 2/3/4 (option).

e This procedure explains to load paper in tray 1. The same procedure is applied to tray 2/3/4.

1 Pull out the paper tray (1).

2 Set the paper size dial (2) to match the

size of the paper to be loaded.

Set the dial to [A4 [J] when loading A4 size
paper in horizontal orientation.

3 Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

- 48 -

( Note)

e When loading A6 size paper, move the paper stopper
(4) forward and remove it once, then install it on the
metal part.

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.

Load paper with the print side face down
and press it from above.

(1 note)

e Do not load paper exceeding the [¥] mark (5) of the
paper guide.

Secure the loaded paper with the paper
guide.

Check if a size of loaded paper matches
the setting of paper size dial.

Return the paper tray to the printer.

e If loading a paper that you cannot select the
size with a paper size dial options, set the dial to
[Other], and then set a paper size on the operator
panel.

Open a file you want to print, and print it.



How to Print from the MP Tray

e How to Print from the MP Tray

This procedure explains how to load paper in the MP tray.

(1t Note)

e Do not load paper of different sizes, types or weights at the same time.

e When adding paper, remove the paper on the MP tray and straighten the edges of both stacks of paper, and then load them
again.

e Do not put anything other than paper for printing in the MP tray.

1 Open the MP tray (1) forward by 4 Open the paper set cover (5).
inserting your fingers into the front
recesses (2).

2 Pull out the paper support (3) by holding
the center part of it.

6 Insert the paper with the print side face
up.
(! Note)

e Do not load paper exceeding the [¥] mark (7) of the
paper guide.

- 49 -
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How to Print from the MP Tray

When loading paper vertically or horizontally
ABC

4 1

o8V

Com-10, DL, C5 ca

e When loading envelopes in the MP tray, load them face up
with the orientation noted below.

- Com-10, DL and C5 are loaded with the flap folded
and the flap should come to the top side in the feeding
direction.

- C4 is loaded with the flap folded and the flap should
come to the right side in the feeding direction.

(1 Note)

e The paper may be wrinkled or curled after printing.

e Use paper stored in proper temperature and humidity
conditions. Do not use paper that is curled or waved
because of humidity.

e Do not print on the back side of paper on which other
printer has printed.

e Curling of a postcard or an envelope may cause the ink
absorbing problem. Use paper that is not curled. Correct a
paper Curling within 2 mm.

e Printing an envelope with an adhesive flap bent cause the
ink absorbing problem.

7 Close the paper set cover (5).

If always printing on same size or type paper
from the MP tray, register the paper on the
operator panel. If printing once, proceed to the
step 18.

(! Note)

e When a printer is in the power saving mode, press
the <POWER SAVE> button to restore from the
mode.

e Make sure that the message "Ready To Print” is
displayed in the operator panel. If the message is not
displayed, press the <ON LINE> button.

Press the <Fn> key.

ON LINE

ABC  DEF

GHI  JKL  MNO

TUV  WXYZ

CANCEL

9 Enter "90” and press the <ENTER>

button.

BAck X
—ppRCHOn BumRer.
Enter 1-3digit Number
D CANCEL

- Meny ~. ON LINE

ENTER @

Function Number

10 When [Paper Size] is displayed, select

the size of the loaded paper and then
press the <ENTER> button.

./ MENU \.
Paper Size  1/11 Back ENTER
A3—ﬁ D
AA T
(A4 1]
Aoy [ D

EE Reference

e If [Custom] is selected for [Paper Size], you need
to register the custom size. For how to register the
custom size, refer to “Printing in Custom Sizes”
P.53.




How to Print from the MP Tray

11 Press the <BACK> button until
[MPTray Config] is displayed.

MPTray Config 1/1
|-Paper Size
Media Type
Media Weight
Tray Usage

12 Press the scroll button ¥ to select
[Media Type] and then press the
<ENTER> button.

MPTray Config 1/1
DanAr Cion
EMedia Type

Viedla weignt
C
Tray Usage

13 Press the scroll button ¥ to select the
type of the loaded paper and then press
the <ENTER> button.

Media Tvpbe 1/3

Lewerneau
Transparency H
Labels

14 Press the <BACK> button until
[MPTray Config] is displayed.

MPTray Config 1/1
Paper Size

Media Weight
Tray Usage

15 Press the scroll button ¥ to select
[Media Weight] and then press the
<ENTER> button.

MPTray Confi 1/1

Paper Size
Madia Tuna

Media Weight

—ilay usdygc

16 Press the scroll button ¥ to select the
weight of the loaded paper and then
press the <ENTER> button.

Media Weiaht 1/2
vieamurm rigrncu
Medium

Heavy

17 Press the <ON LINE> button to exit the
menu mode.

N ONLINE

D @G

0

18 Open the file you want to print, and print
it by following the procedures below.

For Windows PCL Printer Driver

1 From the [File] menu, select [Print].
2 Click [Preferences] or [Properties].

3 On the [Setup] tab, select a paper size
from [Size].

4 Select [Multipurpose Tray] from
[Source].

5 Start printing.
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How to Print from the MP Tray

For Windows PS Printer Driver

1
2
3
4

(3,

7
8

From the [File] menu, select [Print].
Click [Preferences] or [Properties].
Select the [Paper/Quality] tab.

Select [Multi-Purpose Tray] from
[Paper Source].

Click [Advanced].

Click [Paper Size] and select a paper
size from the drop-down list.

Click [OK].

Start printing.

For Mac OS X Printer Driver

1

From the [File] menu, select [Page
Setup].

Select a paper size from [Paper Size]
and then click [OK].

From the [File] menu, select [Print].

Select [Paper Feed] from the panel
menu.

Select [All pages From] and then select
[Multi Purpose Tray].

Start printing.



Printing in Custom Sizes

e Printing in Custom Sizes

To load custom size paper, you need to register the width and length of the paper before printing. The
range of the sizes you can set differs according to the paper tray.

Tray Available size range
Trayl Width:
105 to 297 mm (4.1 to 11.7 inches)
Length:

148, 182 to 431.8 mm
(5.8, 7.2 to 17.0 inches)

Tray 2/3/4 | Width:

(Option) 148 to 297 mm (5.8 to 11.7 inches)
Length:
182 to 431.8 mm (7.2 to 17.0 inches)
MP tray Width:
64 to 297 mm (2.5 to 11.7 inches)
Length:
90 to 1321 mm (3.5 to 52 inches)
(! Note)

e [Custom] is displayed only when [Paper Size] is set to
[Custom].

e The available size range for duplex printing is the same as
that for tray 2/3/4.

1 Press the scroll button ¥ or A on the
operator panel.

o Menu ON LINE

BACK D ENTER
B

2 Press the scroll button ¥ several times
to select [Menus] and press the
<ENTER> button.

Functions 1/2
Configuration i
Print Information I
Drint Caciira_lnh

[EMenus |

3 Check that [Tray Configuration]
is selected and press the <ENTER>
button.

./ MEeNU \.

BACK D ENTER

Maoniic 1/1

| FTray Configuration
LSystem Adjust

4 Press the scroll button ¥ several times
to select [Tray Config] of the paper
tray in which you loaded paper and then
press the <ENTER> button.

Trav Confiauration1/3

[EMPTray Config D)
Irayl Contig
{TrayZ Config
Tray3 Config

5 Check that [Paper Size] is selected and
press the <ENTER> button.

- MEeNu ~.

BACK D ENTER

6 Press the scroll button ¥ several times
to select [Custom] and then press the
<ENTER> button.

MPTrav Canfia _1/1

vedala rype
EMedia Weight
Tray Usage

Paper Size  7/11

LOITI=1U CIivelope
DL Envelope H
C5

v

7 Press the <BACK> button.

oM ON LINE

BACK AD ENTER
O Cance
‘D@ O

- 53 -
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Printing in Custom Sizes

8 Press the scroll button V¥ to select
[X Dimension] and then press the
<ENTER> button.

MPTray Config 1/2
Lbonar Ciza &

Danar Civa

X Dimension []

Y uilimension
I:Media Type

I

9 Enter the paper width value using
the ten-key pad and then press the
<ENTER> button.

Menu

ENTER

5.9 5

ONLINE

O

CANCEL

10 Press the <BACK> button.

MEeNu

ON LINE

CANCEL

OO

ABC DEF

olelo)

GHI JKL  MNO

DOD®O®

PQRS TUV  WXYZ

@ ©

11 Press the scroll button ¥ to select
[Y Dimension] and then press the
<ENTER> button.

Pap: ¢
[EY Dimension i

rricdia Type

]
v

12 Enter the paper length value using
the ten-key pad and then press the
<ENTER> button.

Y Dimension
* R millimeter

Menu

ENTER

So o

ON LINE

O

CANCEL

®®®

GHI JKL MNO

D®O®

PQRS TUV  WXYZ

@O

CLEAR

13 Press the <ON LINE> button to exit the

menu mode.
NU ONLINE @
Y |@¢
D CANCEL @
© PQRS TU
G

14 Specify a custom in the following

procedures.

For Windows PCL Printer Driver

Click [Start] and select [Devices and
Printers].

Right-click the Yowr Printer icon and
select the type of driver you want to
specify from [Printing preferences].

On the [Setup] tab, click [Paper Feed
Options].

Click [Custom Size].
Enter a name and the dimensions.

a Enter a name for the new size in the
[Name] box.

b  Enter its dimensions in the [Width]
and [Length] boxes.

Click [Add] to save the custom paper
size to the list and then click [OK].

You can save up to 32 custom sizes.

Press [OK] until the [Printing
preferences] dialog box is closed.

Open the file you want to print.

Select the registered paper size and
start printing on the print dialog.



Printing in Custom Sizes

For Windows PS Printer Driver For Mac OS X Printer Driver
. . (! Note)
1 CI'E:k [Start] and select [Dewces and e In the Mac OS X printer driver, paper size out of the
Prlnters]. available range can be set, however, image is not correctly

printed. set paper size within available range.
2 Right-click the Your Printer icon and _ _
select the type of driver you want to 1 Open the file you want to print.

specify from [Printing preferences]. 2 From the [File] menu, select [Page

3 On the [Layout] tab, click [Advanced]. Setup].
4 Click [Paper Size] and select 3 Select [Manage Custom Sizes] from
[PostScript Custom Page Size] from [Paper Size]

the drop-down list.
rop-cown 1 4 Click [+] to add an item to the list of

5 Enter the dimensions in the [Width] and custom paper sizes.
[Height] boxes, and press [OK].

(1t Note)

e [Offsets Relative to Paper Feed Direction] is not
available.

5 Double-click [Untitled] and enter a
name for the custom paper size.

6 Enter the dimensions in the [Width] and

6 Press [OK] until the [Printing [Height] boxes.
preferences] dialog box is closed. 7 Click [OK].

7 Open the file you want to print from the

application. 8 Click [OK].

8 Select [PostScript Custom Page Size] 9 From the [File] menu, select [Print].

for a paper size and start printing on the 10

printer driver Configure other settings if necessary and

then start printing.

uonedtadp oiseg bunuid 7
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Printing in Custom Sizes

O Open the file you want to print, and print

it in the following procedures.

For Windows PCL Printer Driver

For Mac OS X Printer Driver

1

-

5

From the [File] menu, select [Print].
Click [Preferences] or [Properties].

On the [Setup] tab, select a paper size
from [Size].

Select [Multipurpose Tray] from
[Source].

Start printing.

For Windows PS Printer Driver

1
2
3
4

(3,

From the [File] menu, select [Print].
Click [Preferences] or [Properties].
Select the [Paper/Quality] tab.

Select [Multipurpose Tray] from
[Paper Source].

Click [Advanced].

Click [Paper Size] and select a paper
size from the drop-down list.

Click [OK].

Start printing.

From the [File] menu, select [Page
Setup].

Select a paper size from [Paper Size]
and then click [OK].

From the [File] menu, select [Print].

Select [Paper Feed] from the panel
menu.

Select [All] and then select [Multi
Purpose Tray].

Start printing.



Paper Output

e Paper Output

Your printer outputs to the output tray or rear output tray. Paper types that can be outputted to each
stacker are as follows.

Output | Supported Paper output
Stacker | paper type capacity
Output e Plain paper | ¢ 200 sheets (when
Tray e Recycled paper weight is less
paper than 80 g/m?)
Rear e Plain paper | ¢ 100 sheets (when
Output e Recycled paper weight is less
Tray paper than 80 g/m?)
e Envelope e 10 sheets (Ultra
e Index card Heavy paper and
e Label envelopes)
(! Note)

e Do not open or close the rear output tray while printing as
it may result in a paper jam.

B Using the Output Tray

Paper is delivered with the print side face down,

stacked in the order printed.

(1 Note)

e Check that the rear output tray (1) on the rear side of the
printer is closed. If the rear output tray is open, paper is

always outputted to the rear output tray.

e Open the paper supporter (2) so that the printed papers

do not fall down from the output tray.

® Using the Rear Output Tray
Paper is delivered with the print side face up,
stacked opposite the order printed.

1 Pull the rear output tray (1) on the rear

side of the printer and open it outward.

- 57 -
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Convenient Print Functions

e Convenient Print Functions

The following convenient print functions are available. For details, refer to the User’s Manual

(Advanced).

B Printing on Postcards, Reply
Postcards or Envelopes

® Printing on Labels

B Printing on Custom Size Paper
You can register customized paper sizes to the
printer driver so you can print on nonstandard
paper such as banners.

e Printing on custom size paper
A3

A4

A

=>

B Changing the Page Layout

You can change the page layout to multiple print,

booklet print and poster print etc.

eBooklet print
1272
=

!

B Duplex Printing
You can print on both sides of a sheet of paper.

eMultipie print ePoster print

eDuplex prints

B Scaling to Pages
You can print data formatted for one size page
onto a different size page without modifying the
print data.

B Printing Color Data in
Monochrome

B Changing Print Quality

(Resolution)
You can change the print quality to suit your
needs.

® Saving Toner

You can save toner by reducing printing density. A
toner saving can be set in 3 levels.

When printing in 100 % black, you can also
select the setting without a toner saving. Amount
of toner can be saved without affecting any
readability for small characters.

eSaving toner

>

- 58 -

There are many convenient print functions in addition to
those above. Refer to the User’s Manual (Advanced).



Canceling Printing

e Canceling Printing

Press the <CANCEL> button on the operator
panel to cancel print jobs being currently printed
or preparing for a print.

ON LINE @
@ Ci

GHI )
® G

When you press the <CANCEL> button is
pressed, the following message appears.

./ MEeNU \.

Cancel Data? BACK ! ENTER

Do

To cancel printing, select [Yes] and then press
the <ENTER> button.

To proceed to printing, select [No] and then
press the <ENTER> button.

If a printer is not operated for about 3 minutes
while this message appears, the message will go
out and printing proceeds.

uonedtadp oiseg bunuid 7
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Setting the Time that Elapses Before Entering the Power Save Mode

e Setting the Time that Elapses Before Entering the
Power Save Mode

(1 Note)

e When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.
e Check if the message "Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator
pane|_ e The power save time can be selected from the followings:
- [1 minute]
OnLne - [2 minutes]
@ - [3 minutes]
- [4 minutes]
X - [5 minutes]
- [10 minutes]
- [15 minutes]
2 Enter 200" using the ten-key pad and - [30 minutes]
then press the <ENTER> button. - [60 minutes]

* Up to 30 minutes for C823.

o~ Menu ON LINE

BAck ENTER @
Enter 1-3digit Number @ 2

Function Number

PQRS TUV  WXYZ

@O

CLEAR

3 Press the scroll button ¥ or A to specify
the time and then press the <ENTER>
button.

Power Save Timel/3

Z [minutes
3 minutes I]
4 minutes

v

4 Press the <ON LINE> button.
NU \' ON LINE @

ENTER AB

D ole

GHI JK

9 CANCEL @

O |&¢
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Setting the Time that Elapses Before Entering the Deep Sleep Mode

e Setting the Time that Elapses Before Entering the

Deep Sleep Mode

(1 Note)

e When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.
e Check if the message "Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator
panel.

ON LINE

ABC  DEF

GHI KL MNO

TUV  WXYZ

O

2 Enter “201” using the ten-key pad and
then press the <ENTER> button.

o~ Menu ON LINE

BAck ENTER @ 5
@@@ @ D®®

Function Number

1
Enter 1-3digit Number

PQRS TUV  WXYZ

@O

CLEAR

3 Press the ¥ or A to specify the time and
then press the <ENTER> button.

Sleen Time  2/3

ou [T]I[_]UEGS
120 minutes

v

4 Press the <ON LINE> button.

D @G

PQRS TU

@ C

e The sleep time can be selected from the followings:

- [1 minute]

- [2 minutes]

- [3 minutes]

- [4 minutes]

- [5 minutes]

- [10 minutes]

- [15 minutes]

- [30 minutes]

- [60 minutes]

* Up to 30 minutes for C823.

- 61 -
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Setting the Time that Elapses Before Entering the Deep Sleep Mode

Constraints When in Deep Sleep Mode

This section explains constraints when in the deep sleep mode.
The printer may not enter the deep sleep mode if an error is displayed.

Printer Driver Utility Constraints

When the printer goes into the deep sleep mode, the following constraints apply to the printer driver
and utility functions.

When the printer goes into the deep sleep mode, press the <POWER SAVE> button on the control
panel and check that the screen displays the message "Ready To Print”.

If the message "Ready To Print” is displayed, the following constraints do not apply.

Method of resolving

Constraints When in the other than to press the
2k SRS LG Deep Sleep Mode <POWER SAVE>
button
Windows Driver Installer If there is a connection with the -

network, you cannot automatically
get printer option information
when installing a driver.

- 62 -




Setting the Time that Elapses Before Entering the Deep Sleep Mode

Network Function Constraints

In the deep sleep mode, the following
constraints apply to network functions.

B Does Not Enter the Deep Sleep

Mode
In the following cases, a printer will not enter
the deep sleep mode.

e IPSec is enabled.
e A TCP connection is established.

E.g.: A connection is established with Telnet or
FTP.

When the transition time to enter Sleep mode
or Deep Sleep mode from Power Save mode
elapses and the connection is disconnected, the
machine enters Sleep mode.

e E-mail reception is enabled.

e Wireless LAN is enabled.

e Google Cloud Print is enabled.

e LLTD is enabled.

e HUB Link Status is 1000BASE-T.
e IPv6 Global Address is assigned.

e Access Control in the Access Control settings
is enabled and Local IC Card or LDAP IC Card
in the Authentication Method is enabled.

e If IPSec is activated.

o If NetBEUI is activated.
e If NetWare is activated.
o If EtherTalk is activated.

e If a TCP connection is being established.
E.g.: If a connection is being established with
Telnet or FTP.
In the power save mode, the printer will go
into the deep sleep mode if the connection is
broken after some time passes.

e When receiving e-mails is activated.

e If you want to activate the deep sleep mode, please
deactivate IPSec/NetBEUI/NetWare/EtherTalk/receiving
e-mail.

® Cannot Print
In the deep sleep mode, you cannot print with
the following protocols.

e NetBEUI
e NBT
e NetWare

e EtherTalk’

e Bonjour (Rendezvous)’

* For Mac OS X, you can print while in deep sleep mode with an IP
Print connection.

B Cannot Search/Cannot Specify

Settings
In the deep sleep mode, you cannot search or
specify settings with the following functions or
protocols.

e PnP-X
e UPnP
e Bonjour (Rendezvous)
e LLTD

e MIB

* You can reference through some supported MIB in the deep sleep
mode (Get command).

B Protocols with the Client

Functions Do Not Work
In the deep sleep mode, the following protocols
with client functions will not work.

e E-mail alerts™
e SNMP Trap

e WINS™
e SNTP?

*1 Time that passes in the deep sleep mode is not included in the
interval for periodic notification by e-mail alert.

*2 Time that passes in the deep sleep mode is not included in the
intervals between WINS updates. Regular WINS updates are not
carried out in the deep sleep mode, so the names registered on the
WINS server may be deleted.

*3 Time that passes in the deep sleep mode is not included in the
interval between update for NTP servers.

B Protocols Needing the Deep Sleep

Mode to be Disabled
When using the following protocols, disable the
deep sleep mode.

e IPV6

NetBEUI
e NetWare
e EtherTalk

e Bonjour (Rendezvous)’

* For Mac OS X, you can print while in deep sleep mode with an IP
Print connection.

- 63 -
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Settings for Turning Power Off Automatically (Auto Power Off)

e Settings for Turning Power Off Automatically

(Auto Power Off)

(1 Note)

e In the factory default, a printer does not enter the auto power off mode while connecting to the network.

Setting the Auto Power Off
Time

To enable the auto power off mode while
connecting to the network perform the following
procedure.

1

Press the scroll button ¥ or A on the
operator panel.

ON LINE

./ MEeNU \.

Press the scroll button ¥ several times
to select [Admin Setup], and press the
<ENTER> button.

Functione 2/2

fiAdmin Setup §

=Lalipration

Enter the administrator password, using
the numeric (0-9) keys.

The factory default password is "999999”. Press
the <ENTER> button whenever inputting one
character.

o Menu ON LINE
Enter Password BACK ) .ENTER @
L
PQRS TUV WXYZ

CLEAR

4 Press the <ENTER> button.

- Menu ~. ON LINE

G2 =

5 Press the scroll button ¥ several times

to select [Power Setup], and press the
<ENTER> button.

Admin Setup 3/4

Memory Setup
System Setup u

Riizzar Saotiin

[ FPower Setup |}

Press the scroll button ¥ several times
to select [Auto Power Off], and press
the <ENTER> button.

Power Setup 1/1

Power Save
Slean

Auto Power Off

Press the scroll button ¥ or A to select
[Enable], and press the <ENTER>
button.

Atitn Ponwer Off  1/1

AUTO Lonrig
Disable

Press the <ON LINE> button to exit the
menu mode.

ON LINE

o~ @
9 DG

3 DG

PQRS TU

®C

CANCEL

O




Settings for Turning Power Off Automatically (Auto Power Off)

Setting the Time that Elapses Before

Entering the Auto Power Off Mode

(! Note)

e When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.

e Check if the message "Ready To Print” appears. If the
message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator
panel.

ON LINE
O

GHI JKL MNO

O |&

TUV  WXYZ

2 Enter “202" using the ten-key pad and
then press the <ENTER> button.

P LI (@)

Function Number BAck ENTER @ ABC  DEF
—pagpction Number
Ezn(t)ezr 1-3digit Number @ @

PQRS TUV  WXYZ

@ ©

3 Press the scroll button ¥ or A to specify
the time and then press the <ENTER>
button.

Aiitn Power OFF T_ .. 1/
Z nours
3 hours n
4 hours u

4 Press the <ON LINE> button.
", @] e
AB

D @G

G (

ON LINE

e The auto power off time can be selected from the
followings:

-[1 hour]

- [2 hours]

- [3 hours]
- [4 hours]
- [8 hours]
-[12 hours]
- [18 hours]
- [24 hours]
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Setting the Buzzer

e Setting the Buzzer

You can specify whether to sound a buzzer when an invalid operation is performed on the operation
panel or when an error occurs.

1 Press the scroll button ¥ or A on the 5 Press the scroll button ¥ several times
operator panel. to select [Buzzer Setup], and press the

<ENTER> button.
- Menu ~. ON LINE

Back ENTER
Admin Setup 3/4
CANCEL EMemory Setup A

Qvctem Setiin ”

| FBuzzer Setup |
FUWCI OcLlup d

2 Press the scroll button ¥ several times
to select [Admin Setup], and press the

<ENTER> button. 6 Press the scroll button ¥ several times

to select [Invalid Operation Volume]
or [Error Volume], and press the
<ENTER> button.

Fiinctinne 2/2

£iAdmin Setup i

=Calipration

Ri177ar Satiin 1/1

[Einvalid Oreration Volu

“=krror Volume

3 Enter the administrator password, using
the numeric (0-9) keys.

The factory default password is "999999”. Press
the <ENTER> button whenever inputting one
character.

7 Press the scroll button ¥ several times
to select a volume level, and press the
<ENTER> button.

IS, e
Enter Password Back — @ = = Invalid Operation Vaual/1
- D e
(6-12digits) @ vald
c

PQRS TUV  WXYZ

4 Press the <ENTER> button.
8 Press the <ON LINE> button to exit the
~ MEeNu ~. ON LINE menu mode.

BACK D ENTER N ON LINE
D5 o

C




3. Troubleshooting

This chapter provides solutions to the problems you may encounter while operating your printer.

e Meanings of symbols in error messages:
- “"%COLOR%" indicates Cyan (C), Magenta (M), Yellow (Y) or Black (K).
- “%TRAY%" indicates tray 1, tray 2, tray 3, tray 4 or the MP tray.
- “"%COVER%" indicates a front cover or output tray.
- “"%CODE%" indicates a code number displayed in 1 to 3 digits. A code number changes according to an error.
- “%MEDIA_SIZE%" indicates paper size.
- “9%MEDIA_TYPE%" indicates a paper type.

e When the message “"Please see Help for details” appears on the display screen, you can check an error code and remedy
error by pressing the <HELP> button on the operator panel.

e When an Error Message Appears on the Display
Screen (When the ATTENTION Indicator Lights
Up/Blinks)

buiyooyss|gqnodl ‘¢

When a printer problem occurs, an error message appears on the display screen and the
<ATTENTION> indicator on the operator panel lights up or blinks. Check the error message and deal
with the problem according to the relevant procedure.

When “Please see Help for details” appears on the display screen, press the <HELP> button to display a
remedy.

<HELP> button Message on the display screen
/

L Meny onLine

BACK ENTER ABC  DEF
L= O
GHI JKL MNO

CANCEL
D odis'

READY
POWER SAVE @

@ ATTENTION

Please see HELP for details.

PQRS TUV  WXYZ

n LEAR
When “Please see Help for details” appears on the display screen,
<ATTENTION> indicator press the <HELP> button to display a remedy. Help is not available
when this message is not displayed.
Display Screen when the <HELP> button is pressed
Error Code Scroll display upward

power save O Here BACK ENTER @ ABC  DEF
@ ATTENTION © XXX X @ A
-

i3 ol

CLEAR

N\
Re‘medy Scroll display downward
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

e When Paper Jams Occurs/When an Error
Message does not Disappear Even After Jammed
Paper is Removed

When paper is jammed inside a printer or when an error message does not disappear even after
jammed paper is removed, an error message appears on the display screen.

Press the <HELP> button to display a remedy. Remove jammed paper according to the remedy
displayed or the relevant procedure described in the following list.

<HELP> button
\

READY
power save O

H

|
Message on the display screen (first line)

XXX X
XXX X

4‘“}Message on the display screen (second line)

N=r

W\

CANCEL

Please see HELP for details.

@ A'r'rloN @

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed

GHI IKL MNO

PQRS TUV WXYZ

CLEAR

Press the <HELP> button to display a remedy.

Error Code Scroll display upward

/ Menu ON LINE

POWER SAVE READY HELP oo BAck X ‘/;Emm @

@ ATTENTION @ A
CANCEL

SR BV £ @lolo)

PQRS TUV WXVZ

®O0

S—

Scroll display downward

Message displayed
Status Message on the Display Screen ;Lt:t';;h; :reil;zz Re;earge:ce
Error Code

Paper jams 1st Line Open Cassette 391, 392, 393, 394 page 76
2nd Line Paper Jam
3rd Line %TRAY %
1st Line Open Cover 372 page 70
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 380 page 71
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 390 page 75
2nd Line Paper Jam
3rd Line Front Cover
1st Line Open Cover 381 page 72
2nd Line Paper Jam
3rd Line Output Tray
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed
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Message displayed
Status Message on the Display Screen zfut:t:);h; :::Ieil;zz Rei;zrge:ce
Error Code

Paper jams 1st Line Open Cover 382, 383 page 73
2nd Line Paper Jam
3rd Line Output Tray
1st Line Check Duplex Unit 370, 371, 373 page 69
2nd Line Paper Jam
1st Line Check Paper 401 page 71
2nd Line Paper Multi Feed
3rd Line %TRAY%

A message does not 1st Line Open Cassette 631, 632, 633, 634 page 76

disappear. 2nd Line Paper Remain
3rd Line %TRAY%
1st Line Open Cover 637 page 75
2nd Line Paper Remain
3rd Line Front Cover
1st Line Open Cover 638 page 72
2nd Line Paper Remain
3rd Line Output Tray
1st Line Open Cover 639, 640 page 73
2nd Line Paper Remain
3rd Line Output Tray
1st Line Check Duplex Unit 641, 642 page 69
2nd Line Paper Remain

Error Code 370, 371, 373, 641, 642 2 Check for jammed paper inside the

printer. If jammed paper remains,

A paper jam has occurred around the duplex
unit.

remove it.

1 Take out the duplex unit (1) by pulling
it obliquely upward while holding the
center recess on the back of printer.

3 Check for jammed paper in the duplex
unit. If jammed paper remains, pull it
out gently.




buiyooyssgnodl ‘¢

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

4

5

Open the upper duplex unit cover (2)
and check for jammed paper. If jammed
paper remains, pull it out gently and
close the cover.

Replace the duplex unit (1) into the
printer.

Task is complete.

Error Code 372

2

Remove the jammed paper gently in
the direction of the arrow if an edge of
jammed paper can be seen, and then
go to step 8. If you cannot find jammed
paper, go to step 3.

3 Take out the duplex unit (3) by pulling

A paper jam has occurred around the front
cover.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

it obliquely upward while holding the
center recess on the back of printer.

4 Check for jammed paper inside a printer.

If jammed paper remains, remove it.

5 Check if paper remains in the duplex

- 70 -

unit. If jammed paper remains, pull it
out gently.




When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

6 Open the upper duplex unit cover (4) Error Code 380, 401, 637

and check for jammed paper. If jammed
paper remains, remove it, and close the
cover.

A paper jam has occurred around the front
cover.

1 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

7 Replace the duplex unit (3) to the
printer.

2 Remove the jammed paper gently in the
direction of the arrow if you can see an
edge of jammed paper.

Task is complete.

-71 -
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

Error Code 381, 638

4 Cover the removed image drums with

A paper jam has occurred under an image drum.

1 Insert your finger into the recess on

the right side of the printer and pull the
front cover open lever (1) to open the

front cover (2) forward.

2 Press the output tray open button (3)
and open the output tray (4).

paper so that the image drums are not
exposed to light.

5 Pull out the jammed paper gently to the

Possible to get
burned.

/\ CAUTION

A\

it.

e The fuser unit is extremely hot. Do not touch

3 Remove all four image drums and place

them on a flat surface.

-72 -

rear of the printer (the direction of the
arrow) if an edge of jammed paper can
be seen.

Pull out the jammed paper gently while
lifting the release levers (5) on the fuser
unit if an edge of jammed paper cannot
be seen.

If an edge of jammed paper still remains inside

the unit, pull out the jammed paper gently to the
rear of the printer.
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6 Return all four image drums into the
printer carefully.

7 Close the output tray (4) by pushing the
both sides of the cover firmly.

8 Close the front cover (2).

(1t Note)

e The front cover cannot be closed if the output tray is
not closed securely.

Task is complete.

Error Code 382, 383, 639, 640

A paper jam has occurred around the fuser unit.

1 Insert your finger into the recess on

the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

2 Press the output tray open button (3)

and open the output tray (4).

& CAUTION Possible to get &

burned.

e The fuser unit is extremely hot. Do not touch
it.

3 Remove all four image drums and place

-73 -

them on a flat surface.
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

4 Cover the removed image drums with 7 Hold the fuser unit handle (6) and lift
paper so that the image drums are not the fuser unit out of the printer.
exposed to light. .

5 Remove the jammed paper remaining

inside of the unit. 8 Lift the release levers (7) on the fuser

unit, and pull out the jammed paper
forward gently.

6 Lift the left lock lever (5) of the fuser

unit forward. ’ 9 Hold the fuser unit handle (6) and place
the fuser unit into the printer.

- 74 -
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10 Push the left lock lever (5) of the fuser 13 Close the front cover (2).
unit backward. ( note)

e Cannot close the front cover securely if the output
tray is not closed.

11 Return all four image drums into the

rinter carefully.
P y Task is complete.

Error Code 390, 637

A paper jam has occurred while feeding paper
from a paper tray.

1 If there is any paper on the MP tray, lift
the paper set cover (1) and take it out.

12 Close the output tray (4) by pushing the
both sides of the cover firmly.

2 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.

- 75 -
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

3 Remove the jammed paper gently by 6 Lower the paper set cover (1).
pulling the edge of paper.

Task is complete.
Remove the paper from the back gently

if the edge of paper cannot be seen. Error Code 391, 392, 393, 394, 631,
632, 633, 634

A paper jam has occurred while feeding paper
from a paper tray.

(t note)

e If paper jams occur frequently, clean the paper feed
rollers. For details, refer to “Cleaning Paper Feed Rollers”

P.109.
This procedure uses Tray 1 as an example.

1 Gently pull out from the printer the tray
(1) for which an error is indicated.

5 1If loading paper on MP tray, lift the
paper set cover (1) and set the paper
with the print side face up.
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2 Remove the jammed paper.

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.

5 Close the front cover (3).

Task is complete.

-77 -

Open and close the front cover after removing the
jammed paper otherwise the error indication do not go
out.
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When the Message for Replacement of Consumables or Maintenance Unit Appears

e When the Message for Replacement of
Consumables or Maintenance Unit Appears

When the time to replace consumables or maintenance unit is close and replacement must be done,
the message "“...Low", “...Near Life”, “...Empty”, “...Life", “Istall...”, "Replace...”, "Change...”
appears on the display screen and the <ATTENTION> indicator on the operator panel lights up or blinks.

Check the message and replace consumables and maintenance unit.

<HELP> button

I B
Rz$ ‘/Message on the dlsplay screen (first line)
XXXX . ..___ RRC hEE
power swve O \HELP XXX <—Message on the dlsplay screen (second I|ne)
ATTENTION XXXX / A\ o N\ = IS & &
' @ Coooe ] Message on the display screen (third Ilne)
ﬂ m\\ N - NS= — M ZNERNCD)
- Message on the dlsplay screen (fourth I|ne)
H‘ CLEAR

Press the <HELP> button to dlsplay a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code Scroll display upwards

XXX X

ABC DEF
POWER SAVE HeLp XXX X Back ENTER
A @O®®»®
ATTENTION GHI JKL MNO
CANCEL
- v . . .
\ PQRS TUV WXVZ

CLEAR

Scroll display downwards
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When the Message for Replacement of Consumables or Maintenance Unit Appears

e “xxx” described on the list below changes according to the printer status.

Message displayed
after the <HELP>

Reference Page or

Online Button

Status Message on the Display Screen button is pressed Remedy
Error Code
Toner Cartridge | 1st Line XXX - Prepare a new toner
2nd Line | %COLOR% Toner Low cartridge, and replace the
old toner cartridge with new
one after a message for
replacement of consumables
or maintenance unit appears.
1st Line XXX - page 97
2nd Line %COLOR% Toner Empty
1st Line XXX - page 97
2nd Line %COLOR% Toner Empty
1st Line Install Toner 410, 411, 412 page 99
2nd Line %COLOR% 413 page 97 (Black toner)
1st Line Install Toner Or Press Online 410, 411, 412 page 97
Button If a black toner remains, you
2nd Line %COLOR% can print in black and white
by selecting [Monochrome].
However, replace the toner
cartridge soon after it runs
out. Otherwise, it may cause
the damage to an image
drum.
Image Drums |1st Line XXX - Prepare new image drums,
2nd Line %COLOR% Image Drum Near and replace the old image
Life drums with new ones after a
message for replacement of
consumables or maintenance
unit appears.
1st Line XXX - page 101
2nd Line %COLOR% Image Drum Life
1st Line XXX - page 101
2nd Line | %COLOR% Image Drum Life, The number of pages you can
%nnn% Pages Left print is displayed in “nnn”.
1st Line XXX - page 101
2nd Line %COLOR% Image Drum Life
1st Line Install New Image Drum 350, 351, 352, 353 page 101
2nd Line Image Drum Life If a toner remains, you can
However, replace the toner
cartridge soon. Otherwise, it
may cause a decrease in a
printing quality.
1st Line Install New Image Drum 560, 561, 562, 563 page 101
2nd Line Image Drum Life
3rd Line % COLOR%
1st Line Install New Image Drum 564, 565, 566, 567 page 101
2nd Line Image Drum Life
3rd Line % COLOR%
4th Line To Exceed the Life, Press
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When the Message for Replacement of Consumables or Maintenance Unit Appears

Message displayed
after the <HELP>

Reference Page or

Status Message on the Display Screen button is pressed Remedy
Error Code
Image Drums |1st Line Install New Image Drum 680, 681, 682, 683 page 101
2nd Line Printing disabled due to low
threshold of Image Drum life.
3rd Line %COLOR%
Fuser Unit 1st Line XXX - Prepare a fuser unit, and
2nd Line Fuser Unit Near Life replace the old fuser unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
1st Line XXX - page 107
2nd Line Change Fuser Unit
1st Line Install New Fuser Unit 354 page 107
2nd Line Fuser Unit Life You can continue to print by
opening or closing the front
cover for a while. However
replace the toner cartridge
soon. Otherwise, it may cause
a printer error or paper jam.
Belt Unit 1st Line XXX - Prepare a belt unit, and
ond Line Belt Unit Near Life replace the old belt unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
1st Line XXX - page 104
2nd Line Change Belt Unit
1st Line Install New Belt Unit 355 page 104
2nd Line Belt Unit Life You can continue to print by

opening or closing the front
cover for a while. However
replace the toner cartridge
soon. Otherwise, it may cause
a printer error.
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When the Message for Paper Replacement or Paper Size Error Appears

e When the Message for Paper Replacement or
Paper Size Error Appears

When the media type or media size loaded in a tray does not match the settings specified in the printer
driver, the message "Change Paper...” or "Check Paper...” appears on the display screen and the
<ATTENTION> indicator blinks.

Check the message and deal with the problem. Check the paper size and the settings, refer to "How to
Print from the Tray” P.48 or “How to Print from the MP Tray” P.49.

<HELP> button

I B
Rs$ ‘/Message on the dlspEysgreen (first line)
POWER SAVE O \HELP 2ACK I

I
XXX <—Message on the display screen (second I|ne)

ArTenTION oo // el 2 =N\ &
' Q Loooc ] Message on the display screen (third Ilne)
I] m\\ N - \NS—= M ZNeRNCD)
- Message on the dlsplay screen (fourth I|ne)
_ 4

CLEAR

Press the <HELP> button to display a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code Scroll display upward

XXXX ABC DEF

BACK ENTER
POWER SAVE HELP XXXX
A @O®®»®
ATTENTION GHI JKL MNO
CANCEL
- \4 . . .
\ PQRS TUV WXVZ

CLEAR

Scroll display downward

Message
displayed after
) the <HELP>
Status Message on the Display Screen button is

pressed

buiyooyss|gqnodl ‘¢

Error Code
Change Paper 1st Line Change Paper in %TRAY% 661, 662, 663, 664
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
1st Line Change Paper in MPTray 660
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
Paper Size does not match print data. 1st Line Change Paper in %TRAY% 461, 462, 463, 464
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button

1st Line Change Paper in MPTray 460
2nd Line %MEDIA_SIZE%
3rd Line %MEDIA_TYPE%
4th Line Press ONLINE Button
Paper Size Error 1st Line Check Paper 400
2nd Line Paper Size Error
3rd Line %TRAY %
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Other Error Messages

e Other Error Messages

This section explains the causes and remedies for an error message and the function of the
<ATTENTION> indicator. An error message appears on the display screen of the operator panel.

To display an error code, press the <HELP> button on the operator panel.

Error Messages

RestorationMemory Overflow

Error <ATTENTION>
code Message indicator Cause/Remedy
420 |Press ONLINE Button for Blinks The memory overflowed.

Reduce the data amount. If that does not
work, reduce the size of the print data.

431 |%TRAY%
432
433
440 |Please see HELP for details
441
442

310 |Close Cover Blinks The cover is open.
311 |[%COLOR% Close the cover.
310 : Output tray
311 : Front cover
Please see HELP for details
320 |Check Fuser Unit Blinks The fuser unit is not correctly installed.
348 Install the fuser unit correctly in a printer.
Please see HELP for details
n* Check Data Blinks Writing of message data to be uploaded to a
Message Data Write Error<%CODE% > printer has been failed.
610 |Toner Not Installed Blinks The toner cartridge of the indicated color
611 |%COLOR% is not installed correctly. Install the toner
612 cartridge correctly.
613 610 : Yellow (Y)
Please see HELP for details 611 : Magenta (M)
612 : Cyan (C)
613 : Black (K)
544 | Check Toner Cartridge Blinks The toner cartridge of the indicated color is
545 |Improper Lock Lever Position not locked properly.
546 |%COLOR% Turn the blue lever on the right side of the
547 cartridge backwards until it stops.
Please see HELP for details 544 : Yellow (Y)
545 : Magenta (M)
546 : Cyan (C)
547 : Black (K)
540 |Toner Sensor Error Blinks Something is wrong with the toner sensor of
541 |%COLOR% the indicated color or the image drum is not
542 installed correctly.
543 Install the toner cartridge or image drum of
the indicated color correctly.
540 : Yellow (Y)
541 : Magenta (M)
542 : Cyan (C)
543 : Black (K)
430 |Install Paper Cassette Blinks A paper cassette is not in the indicated tray.

Insert the paper cassette into the indicated
tray.

If the cassette is already inserted in the
printer, pull out the cassette and set it again
to correctly locate it.

430, 440 : Trayl

431, 441 : Tray2

432, 442 : Tray3

433 : Tray4
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Error <ATTENTION>
code Message indicator Cause/Remedy
356 |[Install New Belt Unit Blinks The belt unit is at the end of its life.
Belt Unit Life Replace it with a new belt unit.
Please see HELP for details
File System is Full Lights up The file system is full.
File System is Write Protected Lights up The file system to which you tried to write is
write-protected.
330 |Check Belt Unit Blinks The belt unit is not properly installed.
Reinstall it properly.
Please see HELP for details
Deleting Encrypted Job Lights up Deleting an encrypted job.
Print Restricted. Job Rejected Lights up A print job sent by a user who is not
authorized for printing is deleted.
Press ONLINE Button
Color Restricted. Job Rejected Lights up A color print job sent by a user who is not
authorized for color printing is deleted.
Press ONLINE Button
Color Restricted. Mono Printed Lights up A color print job sent by a user who is not
authorized for color printing is printed in the
Press ONLINE Button mono-print mode.
Erased Data Full Lights up Secret file to be erased are full.
491 |Install Paper Blinks The indicated tray is empty.
492 |%TRAY% Load the indicated size paper.
493 |%MEDIA_SIZE% 491 : Trayl
494 492 : Tray2
Please see HELP for details 493 : Tray3
494 : Tray4
File Erasing Lights up Erasing a secret file.
Error Postscript Blinks A postscript error has occurred.
490 |Install Paper Blinks Paper in the MP tray is empty.
MPTray Load the indicated size paper.
%MEDIA_SIZE%
Press ONLINE Button
Please see HELP for details
694 |Image Drum Not Installed Blinks The image drum of the indicated color is not
695 |%COLOR% installed correctly. Install the image drum
696 correctly.
697 694 : Yellow (Y)
Please see HELP for details 695 : Magenta (M)
696 : Cyan (C)
697 : Black (K)
340 |Check Image Drum Blinks The image drum of the indicated color is not
341 |%COLOR% installed correctly. Install the image drum
342 correctly.
343 340 : Yellow (Y)
Please see HELP for details 341 : Magenta (M)
342 : Cyan (C)
343 : Black (K)
nnn’ | Wait a Moment Blinks An error has occurred inside the printer.
Rebooting <n> The printer is restarted. 1-digit error code
appears. A code number changes according
to an error.
%COLOR% Toner Sensor Error Lights up Something is wrong with the toner sensor of

the indicated color or the image drum is not
installed correctly.

Install the toner cartridge or image drum of
the indicated color correctly.
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Other Error Messages

Go to User Manual “Trouble Shooting” to
restore operation

Error <ATTENTION>
code Message indicator Cause/Remedy
% COLOR% Toner Not Installed Lights up The toner cartridge of the indicated color
is not installed correctly. Install the toner
cartridge correctly.
%TRAY% Empty Lights up The indicated tray is empty.
Load the indicated size paper.
Unsupported USB Device Detected Lights up A USB device unsupported by a printer is
connected. Remove the device.
Please detach it
Install Paper Blinks Load the paper of the size indicated in the
MPTray MP tray, and then press the <ON LINE>
%MEDIA_SIZE% button.
Press ONLINE Button
%COLOR% Waste Toner Full.Replace Toner. Lights up Waste toner is full. Replace with a new toner
cartridge of the indicated color.
Collate Fail:Too Many Pages Lights up A collate print error has occurred.
Reduce the data amount. If that does not
Press ONLINE Button work, reduce the size of the print data.
File System Operation failed<nnn> Lights up An error of file system for a printer has
occurred.
Press ONLINE Button
Power Off and Wait for a while Blinks A condensation has occurred inside a printer.
126:Condensing Error Turn the printer off and turn on again after
a while.
Invalid Secure Data Lights up Invalid source data is received in an
authentication printing and deleted.
Press ONLINE Button
USB Hub Unsupported Lights up A USB hub unsupported by a printer is
connected. Remove the hub.
Please detach it
Log Buffer is Full. Job Rejected Lights up Print data is deleted because the accounting
log buffer is full. Contact a printer
administrator and remove the log buffer.
Press ONLINE Button
360 |Install Duplex Unit Blinks A duplex unit is not installed correctly.
Install a duplex unit in a printer correctly.
When a duplex unit is already installed, pull
Please see HELP for details out the unit, and then install it again.
nnn* [Service Call Blinks An error occurred inside the printer. Turn the
nnn: Error printer off and then on again.
nnn* [Power Off/On Blinks A fatal error has occurred in a printer.
nnn:Error Write down the indicated alphanumerical
PC:nnnnnnnn characters and contact your dealer.
LR:nnnnnnnn
FR:nnnnnnnn
709 | Caution, unknown Consumable detected Blinks You can use any consumables in your

product, but you must accept the risks of
using non-genuine consumables. If the use
of non-genuine consumables causes damage
to the product or results in your product

not functioning to its full specification, then
such damage or effect on the product is not
covered by warranty. To accept these risks
and to restore function;

1. Turn off your product

2. Press and hold the CANCEL button and
turn your product on

3. After start up, release the CANCEL button

( note)

This operation will be recorded for future
reference.
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When You Cannot Print from the MP Tray

e When You Cannot Print from the MP Tray

If you print from the MP tray without moving down the paper set cover, the message
“Install Paper MPTray” appears on the display screen.

Check the message and deal with the problem. Refer to "How to Print from the MP Tray” P.49.

Paper set cover
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Other Issues

e Other Issues

This section explains the issues you may encounter while operating your printer and how to solve them.

Unable to Print from a Computer

e If the following information does not solve the issue, contact your dealer.

e For issues caused by an application, contact the manufacturer of the application.

General Causes

B Common to Windows and Mac OS X

Cause Remedy Reference
The printer is turned off. Turn on the printer. page 21
An Ethernet or USB cable is unplugged. |Check that the cable is plugged into the printer and -

computer properly.
Something is wrong with a cable. Replace it with a new cable. -
The printer is off line. Press the <ON LINE> button. -
An error message is displayed on the “Error Messages” or press the <HELP> button on the page 82
display screen of the operator panel. operator panel.
The interface setting is disabled. Check the setting of the interface being used from the Advanced
operator panel.

Something is wrong with the print Check if you can print the contents of the settings. page 29
function.
B For Windows

Cause Remedy Reference
The printer is not set as the default Set the printer as the default printer. -
printer.
The output port for the printer driver is | Select the output port to which the Ethernet or USB -
incorrect. cable is connected.
A print job from another interface is in Wait until the print job is done. -
progress.
“"Received invalid data” is displayed on | Press the scroll button ¥ or A and select [System -
the display screen and printing cannot Adjust] > [Timeout InJob], and then select a longer
be done. time. The default setting is 40 seconds.
A print job is automatically canceled. If using Print Job Control, the print job is not authorized Advanced

to print, or the Job Accounting log buffer may be full.
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Network Connection Problems

B Common to Windows and Mac OS X

Cause Remedy Reference
Using a crossover cable. Use a straight cable. -
The printer is turned on before a cable Connect cables before turning on the printer. page 31

was connected.

The hub and the printer are incompatible [Press the scroll button ¥ or A and select [Admin Setup] > -
or have some problem. [Network Setup] > [HUB Link Setting], and then select
[10Base-T Half].

B For Windows

Cause Remedy Reference

IP address is incorrect. e Check that the same IP address is set for the printer -
and the printer's port setting on the computer.

e If using LPR Utility, check the IP address setting in
LPR Utility.

USB Connection Problems

B Common to Windows and Mac OS X

Cause Remedy Reference
Unsupported USB cable is being used. Use a USB 2.0 cable. -
A USB hub is being used. Connect the printer directly to the computer. page 37
Printer driver is not installed correctly. Reinstall printer driver. page 38,
page 39

B For Windows

Cause Remedy Reference

The printer is off line. Right-click the OKI C833 icon, and then select -
[See what's printing] ([OKI C833*] when multiple
printer drivers are installed). In the dialog box, select
the [Printer] menu and then remove the check from
[Use Printer Offline].

* Select the type of a printer driver you want.
A switch, buffer, extension cable or USB |Connect the printer directly to the computer. page 37
hub is being used.

A driver for a different printer that uses a | Delete the other printer driver from the computer. -
USB connection has been installed.
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Other Issues

Unable to Install a Printer Driver Successfully

e If the following information does not solve the issue, contact your dealer.

e For issues caused by an application, contact the manufacturer of the application.

USB Connection Problems

B For Windows

Cause

Remedy

Reference

An icon of the printer is not created on
the [Devices and Printers] folder.

The printer driver is not installed correctly.
Reinstall the printer driver correctly.

page 38

Only the first printer driver is installed
even if multiple printer drivers are
selected to install.

Follow the procedure below to install the second and
subsequent printer drivers:

1. Insert the “Software DVD-ROM” into a computer.

2. When [AutoPlay] is displayed, click [Run Setup.exe].

e If the [User Account Control] dialog box is displayed,
click [Yes].

. Select a language from the drop-down list.

. Read the license agreement, and then click [Accept].

. Read Environmental advice for Users and click

[Next].

6. Select [Network (Wired/Wireless)] or [USB]
corresponding to your connection environment, and
then click [Next].

If the [Windows Security Alert] dialog box is
displayed, click [Allow access].

7. Select the model name of this machine, and then
click [Next].

8. Click [Custom Install].

9. Click [Separate Install].

10. Click a driver to install.

Installation starts.

u b w

The “Unable to install printer driver”
error message is displayed.

Use Plug-and-Play. Follow the procedure below.

1. Ensure that the printer and computer is turned off.

2. Connect a USB cable.

3. Turn on the printer.

4. Turn on the computer.

5. When the Found New Hardware Wizard is displayed,
follow the on-screen instructions to complete the
setup.
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OS-Specific Constraints

Constraints with Windows

Item

Symptom

Cause/Remedy

Printer drivers

[Help] is not displayed.

The [Help] function is not supported on PS printer drivers.

The [User Account Control]
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.

Color Correct
Utility

The [User Account Control]
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.

The [Program Capability
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears
after an installation (including if you stop an installation
before it is completed), make sure to click [This program
installed correctly].

PS Gamma
Adjuster

The [User Account Control]
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.

The [Program Capability
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears
after an installation (including if you stop an installation
before it is completed), make sure to click [This program
installed correctly].
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Other Issues

Image Quality Issues

e If the following information does not solve your issues, contact your dealer.
Symptom Point to check Remedy Reference
Vertical lines appear. The LED heads are dirty. Wipe the LED heads with a soft page 111
tissue paper.
‘ The toner is low. Replace the toner cartridge. page 97
W The image drum is damaged. Replace the image drum. page 101
Foreign materials may be present |Replace the image drum. page 101
on the image drum.
Paper feed direction The light-shielding film of the Wipe the film with a soft tissue -
image drum is dirty. paper.
The image drum is not installed Install the image drum properly. page 101
properly.
Printed images are The LED heads are dirty. Wipe the LED heads with soft page 111
fading vertically. tissue paper.
The toner is low. Replace the toner cartridge. page 97
|||||l|| Iy iy The paper is unsuitable. Use supported paper. page 43
A'I " ll\u |||I]|lumlHII
Paper feed direction
Printed images are light. | The toner save is enabled. Change the toner save settings. -
The toner cartridge is not installed |Install the toner cartridge properly. page 97
properly.
The toner is low. Replace the toner cartridge. page 97
The paper is moist. Use paper stored in proper page 43
temperature and humidity
conditions.
The paper is unsuitable. Use supported paper. page 43
The paper is unsuitable. Press the scroll button v or A page 43
The settings of media type and and select [Menus] > [Tray
weight are incorrect. Configuration] > the paper tray
configuration you are using, and
then select the proper values
for [Media Type] and [Media
Weight]. Or, select a larger value
for [Media Weight].
The paper is recycled. Press the scroll button v or A page 43
The media weight setting is and select [Menus] > [Tray
unsuitable. Configuration] > the paper tray
you are using, and then select a
larger value for [Media Weight].
Printed images are The paper is too moist or dry. Use paper stored in proper page 43

partially faded. Spots
and lines appear.

i

temperature and humidity
conditions.

[Paper Black Setting] or [Paper
Color Setting] is improperly
configured.

Press the scroll button v or A,
select [Menus] > [Print Adjust],
and then change the value of
[Paper Black Setting] or [Paper
Color Setting].

[Films Black Setting] or [Films
Color Setting] is improperly
configured.

Press the scroll button v or A,
select [Menus] > [Print Adjust],
and then change the value of
[Films Black Setting] or [Films
Color Setting].
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Symptom Point to check Remedy Reference
Horizontal lines If the interval of lines or spots Lightly wipe the image drum with page 101
and spots appear is about 94 mm (4 inches), the soft tissue paper.
periodically. image drum (the green tube) is Replace the image drum if it is

damaged or dirty. damaged.
— || If the interval of lines or spots is Open and close the output tray, -
about 40 mm (2 inches), foreign and print again.
materials may be present on the
image drum.
Paper feed direction If the interval of lines or spots is  [Change the fuser unit. page 107
about 143 mm, there is damage to
the fuser unit.
The image drum has been exposed | Place the image drum back into page 101
to light. the printer and leave it for a few
hours. If that does not solve the
problem, replace the image drum.
The paper feed path is dirty. Print a few test copies. -
White area of paper is The paper contains static Use paper stored in proper page 43
lightly stained. electricity. temperature and humidity
conditions.
The paper is too thick. Use thinner paper. -
The toner is low. Replace the toner cartridge. page 97
Periphery of letters is The LED heads are dirty. Wipe the LED heads with soft page 111
smudged. tissue paper.
The paper is unsuitable. Use recommended paper. -
The paper is moist. Replace it with new paper. page 43
The entire paper area The toner may be sticking to the |This is not a malfunction of the -
is lightly stained when whole area of the envelope or printer.
printing on envelopes or |coated paper. Coated paper is not recommended.
coated paper.
o=
Toner comes off when it | The settings of media type and Press the scroll button v or A page 43
is rubbed. weight are incorrect. and select [Menus] > [Tray
Configuration] > the paper
tray configuration you are using,
and then select the proper
values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
The paper is recycled. Press the scroll button v or A page 43
The media weight setting is and select [Menus] > [Tray
unsuitable. Configuration] > the paper tray
configuration you are using, and
then select a heavier weight for
[Media Weight].
Glossiness is not The settings of media type and Press the scroll button v or A page 43

uniform.

weight are incorrect.

and select [Menus] > [Tray
Configuration] > the paper

tray configuration you are using,
and then select the proper

values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
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Symptom Point to check Remedy Reference

Color of the printed The toner is low. Replace the toner cartridge. page 97

image is not what you The setting of [Black Finish] is On the printer driver, select Advanced

expect. not suitable for the application. [Composite Black (CMYK)]
of [True Black (K)] for [Black
Finish].
The color adjustment has been Do color matching from the printer Advanced
modified. driver.
The color balance is out of Press the scroll button v or A and Advanced
adjustment. select [Calibration], and then
[Adjust Density].
Color registration is out of Open and close the output tray. Advanced
alignment. Or, press the scroll button v or a
and select [Calibration], and then
[Adjust Registration].
Solid printing of CMY [CMY100% Density] is set to Press the scroll button v or A and -
100% is too light. [Disable]. select [Admin Setup] > [Color
Setup] > [CMY100% Density],
and then select [Enable].

Dots appear. The paper is unsuitable. Use supported paper. page 43
When the interval of the dots Lightly wipe the image drum with a page 101
is about 94 mm (4 inches), the soft tissue paper.
image drum (the green tube) is Replace the image drum when it is
damaged or dirty. damaged.

Smears is printed. The paper is moist. Replace it with new paper. page 43
The paper is unsuitable. Use supported paper. page 43

The background of a The printer may be malfunctioning. | Contact your dealer. Back cover

printed page is dark or

dirty.

Nothing is printed. Two or more sheets of paper are Fan the paper well and load it page 48,
fed simultaneously. again. page 49

2 The printer may be malfunctioning. [ Contact your dealer. -

Patches appear. The paper is moist. Replace it with new paper. page 43

The paper is unsuitable. Use supported paper. page 43
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Feeding Issues

e If the following information does not solve the issue, contact your dealer.

Symptom Point to check Remedy Reference
e The paper often [The printer is tilted. Place the printer on a flat surface. page 16
jams. The paper is too light or too heavy. |Use the appropriate paper for the page 43
e Multiple sheets printer.
are fed at once. - rhe paper is moist or has a static Use paper stored in proper page 43
e The paper is fed h d humidi
at an angle charge. temperature and humidity
' conditions.
The paper is wrinkled, folded or Use appropriate paper for the printer. page 43
curled. Fix the curled paper.
Something is already printed on the |With tray 1/2/3/4, you cannot use page 49
back side of the paper. paper that has been printed.
Load it on the MP tray for printing.
The edges of the paper are not kept [Fan the paper and even up the page 48,
even. edges. page 49
There is only one sheet of paper in Load several sheets of paper. page 48,
the tray. page 49
You have added more paper with Remove the already loaded paper, page 48,
paper already loaded in the tray. stack it onto the new paper, even up page 49
the edges and load the paper with
the old paper on top.
The paper is loaded at an angle. For tray 1/2/3/4, adjust the paper page 48,
width guide and stopper to the page 49
paper.
For the MP tray, adjust the paper
width guide to the paper.
Envelopes are not correctly loaded. Load envelopes correctly. page 49
Paper, envelopes or labels of weight [Load the paper, envelopes or labels page 43,
between 177 and 220 g/m? is loaded |of weight between 177 and 220 g/m? page 49
in tray 1 and tray 2. on the MP tray, and use the face up
stacker.
Paper does not feed | The setting of [Source] in the Check the paper tray and select -
into the printer. printer driver is not correctly the correct tray in [Source] in the
specified. printer driver.
You have specified manual feeding In the printer driver, clear the [Use Advanced
on the printer driver. MP tray as manual feed] check
box on [Paper feed options].
The printer does - Open and close the output tray. -
not start processing
even though you
have removed the
jammed paper.
The paper gets The paper is moist or has a static Use paper stored in proper page 43
folded or wrinkled. |[charge. temperature and humidity
conditions.
The paper is light. Press the scroll button v or A page 43
and then select [Menus] >
[Tray Configuration] > [(tray
name) Config] > [Media Weight].
Then, specify a lighter weight.
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Other Issues

Symptom

Point to check

Remedy

Reference

The paper twists
around the rollers
in the fuser unit.

The settings of media weight and
type are incorrect.

Press the scroll button v or A

and then select [Menus] >

[Tray Configuration] > [(tray
name) Config] > [Media Type]/
[Media Weight]. Then, specify the
appropriate values.

Or, specify a heavier weight in
[Media Weight].

page 43

The paper is light.

Use heavier paper.

There is an image or text on the
leading edge of the paper.

Add a margin on the leading edge of
the paper.

For duplex printing, leave a margin
in the leading and bottom edges.

Machine Issues

is blank.

mode.

button lights up and press the
<POWER SAVE> button to activate
the printer.

Symptom Point to check Remedy Reference
You turned on the |The AC cord is unplugged. Turn off the printer and then plug in -
printer, but nothing the AC cord firmly.
displays on the The power is out. Check if the power is being supplied -
screen. to the electric outlet.
The printer does The AC cord is not firmly plugged in. |Plug in the AC cord firmly. -
not operate. The printer is turned off. Turn on the printer. page 21
The printer turned off automatically |Disable the auto power off function. page 64
by the auto power off function.
Printer does not answer. Hold down the power switch for more -
than 5 seconds to turn off the printer
forcibly.
The printer does An error is displayed on the panel. Check the error code and follow the page 82
not start printing. on-screen instructions.
The Ethernet or USB cable is Plug in the Ethernet or USB cable page 31,
unplugged. firmly. page 37
Something is wrong with the Use another Ethernet or USB cable. -
Ethernet or USB cable.
The printer does not support your e Use a USB 2.0 compatible cable. -
Ethernet or USB cable. e Use an Ethernet 10BASE-T/
100BASE-TX/1000BASE-TX
compatible cable.
Something may be wrong with the Press the scroll button ¥ or A and page 29
printing function. select [Print Information] >
[Configuration] and then print the
contents of the settings to check the
printing function.
The interface is disabled. Press the scroll button v or A and -
select [Admin Setup] > [Network
Setup] and enable the interface you
are using.
The printer driver of the printer is Set the printer driver of the printer -
not selected. as the default printer.
The specified port of the printer Specify the port the Ethernet or USB -
driver is wrong. cable is connected to.
The display screen |The printer is in the deep sleep Check if the <POWER SAVE> page 22

Print data is not
transmitted to the
printer.

The Ethernet or USB cable is broken.

Connect a new cable.

The time-out period set on the
computer has passed.

Set a longer time-out period.
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Other Issues

Symptom Point to check Remedy Reference
There is an The printer is tilted. Place the printer on a flat surface. -
abnormal sound. There is a piece of paper or foreign |Check the inside of the printer and -

object inside the printer. remove any objects.
The output tray is open. Close the output tray. -
There is a buzzing |The printer is printing on the heavy |[This is not a malfunction. You can -
sound. or thin paper when the temperature |proceed with the operation.
inside is high.
It takes a while to |The printer may be cleaning the Wait for a while. -
start printing. image drum.
The printer is adjusting the Wait for a while. -
temperature of the fuser unit.
The printer is processing data from Wait until the process finishes. -
another interface.
A print job has As a result of processing print jobs Wait for a while. -
stopped in the continuously for a long time, the When the fuser unit becomes cooler,
middle of the inside the printer has become hot. printing restarts automatically.
printing process. The printer is cooling off.
As a result of processing print jobs Wait for a while. -
continuously for a long time, the When the printer becomes cooler,
temperature in the printer inside printing restarts automatically.
has become too high. The printer is
cooling off.
When the print processing is Retry to send data on a computer. If -
overloaded by printing with the WSD |the error is not resolved, use other
port, a computer may stop sending. [network port.
Memory is A printer is short on memory Reduce print data with a printer Advanced
insufficient. because print data is too large. driver.
It takes a long time [ The processing speed of the Use a computer with faster -
to finish printing. computer may be slowing down the |processing speed.
print job.
You have selected [ProQ/High Select [Fine / Detail (600x1200)] -
Quality] on the [Job Options] tab |or [Normal (600x600)] on the
of the printer driver. [Job Options] tab of the printer
driver.
The print data is complex. Make the data simpler. -
Paper is narrow (less than 230 mm). | Change the mode. Advanced
The printer driver | The printer driver may not be Uninstall the printer driver and install Advanced
is not correctly operating correctly. it again.
displayed on Mac
OS X.
Paper is curled. Thin paper is used. Set an appropriate paper weight or Advanced
select [High Humid Mode].
Paper is wet on the |Wet paper is used. Select [High Humid Mode]. Advanced
edge.
The LED indicator [The printer may be malfunctioning. : . -
in the power switch % Unplug the AC cord immediately.
is blinking at high
speed per about
0.3 seconds.
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4. Maintenance

This chapter explains how to replace consumables and maintenance units, clean the printer, and move
or transport the printer.

e Replacing Consumables and Maintenance Units

This section explains how to replace consumable items.

/\ WARNING

®

Do not throw the toner or
toner cartridge into the fire.
Doing so may cause toner
splashes leading to burns.

O

Do not keep the toner
cartridge in places close to
the fire. It may catch the
fire, which cause fire and
burns.

O

Do not vacuum spilled toner
powder. If vacuuming, it may
cause ignition due to the
sparks from electric contacts.
Toners spillage on the floor
should be wiped off by wet
clothes.

/\ CAUTION

There are high temperature
parts in the device. Do

not touch the periphery

of the label "Caution High
Temperature", which may
cause burns.

Keep the toner cartridge out
of reach of young children. If
young children swallow toner
powder, follow the doctor's
direction immediately.

If toner powder is inhaled,
gargle with large amounts of
water and move the person
to the open area for fresh air.
Follow the doctor's direction
if necessary.

o

If the toner powder sticks to
your skin like your hands,
wash with soap.

e

If the toner gets into the
eyes, flush with plenty of
water immediately. Follow
the doctor's direction if
necessary.

If you swallow toner powder,
take large amounts of water
to weaken the toner. Follow
the doctor's direction if
necessary.

©

When handling a paper
jam, or replacing the toner
cartridge, make sure not to
get your cloth and hands
dirty. When toner powder
stains on your cloth, wash
with cold water. If you wash
with hot water, the toner
may be soaked into the
cloth; it may be difficult to
clean.

@

Do not disassemble the toner
cartridge. Toner powder may
fly upward, and you may
inhale the toner powder

or may get your cloth and
hands dirty.

Keep a used toner cartridge
in a bag so that the toner
powder can not fly upward.

(1t Note)

e Use only genuine Oki Data consumable items to ensure optimum quality.

e Service for problems due to use of consumable items other than genuine OKI consumables will incur fees even in the warranty
period or the maintenance contract period.
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Replacing Consumables and Maintenance Units

- - Procedure for Replacement
Replacing Toner Cartridges (for K (black) Toner Cartridge)

(o)
e Toner powder may spill if you remove a toner cartridge e When replacing the C, M, Y toner cartridges, refer to
before the toner runs out. “Procedure for Replacement
(for C (cyan), M (magenta),

Life Span of Toner Cartridge Y (yellow) Toner Cartridges)” P.99.

When the "% COLOR% Toner Low” message 1 Prepare a new [K] toner cartridge.
("%COLOR%" indicates C (cyan), M (magenta),

Y (yellow) or K (black)) appears on the display 2 Insert your finger into the recess on
screen, prepare a replacement toner cartridge. the right side of the printer and pull the
You can keep printing several hundred pages front cover open lever (1) to open the

until the next message appears. front cover (2) forward

The number of pages that can make prints
depends on the usage.

When the "% COLOR% Toner Empty” appears
and printing is stopped, replace the toner
cartridge.

e Even if the cyan (blue), magenta (red) or yellow toner
cartridges run out, you can print in black and white by
selecting [Monochrome] or [Grayscale]. However,
please replace the toner cartridge quickly after it runs
out, as not doing so may cause the image drum to be
damaged.

(! Note)
e The actual life of the toner cartridge differs depending on 3 Turn .the blue lever (3) of the toner
the usage. cartridge.

(! Note)

Have a new print cartridge ready, as the print quality
declines after more than one year following breaking the
seal.

e If you replace the toner cartridge/image drum while it is
being used, the amount of toner used will not be counted
normally.

e By opening and closing the output tray after the message
“Color toner has run out” is displayed, you are able
to print approximately 100 copies of A4 size ISO test
patterns (approximately 20 pages, five times). However
further printing operations will not be possible after that.
Please replace the toner cartridge as failure to do so may
damage the image drum.
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Replacing Consumables and Maintenance Units

4 Lift the toner cartridge (4) from the right
side, and remove it from the printer.

Possible to get
AWARNING|  Posphieloget | A\

e Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside

may fly off and cause getting burned.

(! Note)

e When toner powder adheres to the paper feeding area
inside the printer, wipe it off with a wet cloth that has
been well wrung.

5 Leaving the replacement toner cartridge
in its bag, gently shake it up and down
and side to side, and then unpack it.

6 Remove the tape (5) from the toner
cartridge.

7

8

Insert a new toner cartridge (6) by
aligning its left side indentation (7) with
the protrusion (8) on the image drum so
the toner cartridge and image drum [K]
color label align. Then fix the right side
firmly into place.

C! Note)

e Do not insert a toner cartridge without removing the
tape.

Turn the blue lever (3) of the toner
cartridge backward until its top aligns on
the A mark.

9 Close the front cover (2).

(! Note)
e The front cover cannot be closed if the output tray is
not closed securely.




Replacing Consumables and Maintenance Units

10 Please recycle toner cartridges.

e If you must dispose of a toner cartridge, put it in a plastic
bag or similar container and dispose of it in accordance
with your municipality’s ordinances or guidelines.

Procedure for Replacement
(for C (cyan), M (magenta),
Y (yellow) Toner Cartridges)

e When replacing the K toner cartridge, refer to “Procedure

for Replacement
(for K (black) Toner Cartridge)” P.97.

1 Prepare new toner cartridges.

2 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3 Press the output tray open button (3)
and open the output tray (4).

Possible to get
/N\ CAUTION B /A
e The fuser unit is extremely hot. Do not touch
it.
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Replacing Consumables and Maintenance Units

4 Identify an empty toner cartridge by its 7 Unpack the replacement toner cartridge,
label color (5). and gently shake it up and down and
side to side.

5 Slide the right blue lever (6) of the toner 8 Remove the tape (8) from the toner
cartridge while pressing the top of the cartridge.
cartridge to unlock.

9 Insert a new toner cartridge (9) by
aligning its left side indentation (10)
with the protrusion (11) on the image
drum so the toner cartridge and image

side, and remove it from the printer. right side firmly into place.
Possible to get ( note)
AWARNING burned. & e Do not insert a toner cartridge without removing the
tape.

e Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside
may fly off and cause getting burned.
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Replacing Consumables and Maintenance Units

10 Turn the blue lever (6) of the toner

cartridge backward until its top aligns on

the A mark.

11 Close the output tray (4) by pushing the

both sides of the cover firmly.

(! Note)

e The front cover cannot be closed if the output tray is
not closed securely.

13 Please recycle toner cartridges.

Replacing the Image Drum

Life Span of Image Drum

When the "% COLOR% Image Drum Near
Life” message appears on the display screen,
prepare a replacement image drum.

If you continue printing, the message

"9 COLOR% Image Drum Life” will be
displayed and printing will stop.

A guideline for replacing the image drum is
every 30,000 pages or so for A4 sized paper
(with single-sided printing). However, this
number of pages is for common printing

conditions (3 pages at a time). Printing one page
at a time reduces the drum life by about half.

The actual number of printed pages may be
halved again relative to the above guideline,
depending on the printing conditions.

If you continue to print more than the above,
the printer will force the printing to stop.

(! Note)

The actual number of pages you can print with the image
drum depends on how you use it. The above guideline
may be reduced by more than half, depending on the
conditions of printing.

Though opening and closing the output tray may extend
the life of a image drum for a while, it is recommended to
replace it soon after the “Install New image drum” is
displayed.

The print quality may deteriorate after the toner cartridge
has been unpacked for a year. Replace it with a new one.

Press the scroll button ¥ or A button > [Admin Setup] >
[System Setup] > [Near Life Status] is set to [Disable],
the "% COLOR% Image Drum Near Life” message does
not appear.

Procedure for Replacement

(! Note)

e If you must dispose of a toner cartridge, put it in a plastic

bag or similar container and dispose of it in accordance
with your municipality’s ordinances or guidelines.

- 101 -

If you use a new image drum with the toner cartridges
currently in use, the remaining amount indication of the
toner cartridges will not display correctly.

The messages "% COLOR% Image Drum Near Life” or

"% COLOR% Image Drum Life” may also be displayed
soon after replacement.

The image drum (the green tube) is very delicate. Handle
it carefully.

Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

In order for the printer to exhibit its full performance,
please use genuine Oki Data consumables.

Service for problems due to use of consumable items
other than genuine OKI consumables will incur fees

even in the warranty period or the maintenance contract
period. (Use of consumable items other than genuine OKI
consumables does not always cause problems, but please
exhibit caution when using those.)

QoueusuIelp i



2oueusjulelp b

Replacing Consumables and Maintenance Units

e There is one toner cartridge for each color on the image 5 Remove the image drum (6) from the
drum. printer in the direction of the arrow and

1 Prepare a new image drum place the image drum on a flat surface.

2 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

6 Turn the right blue lever (7) of the toner
cartridge forward while pressing the top

f the t tri to unlock.
3 Press the output tray open button (3) of the toner cartridge to unloc

and open the output tray (4).

Possible to get
/\ CAUTION burmed. /A
e The fuser unit is extremely hot. Do not touch
it.

7 Lift the toner cartridge (8) from the
right side, and remove it from the image
drum.

&WARNING Possible to get &

burned.

e Do not throw a used image drum and toner

. . . cartridge in the fire. They may explode, and

4 Identify an empty toner cartridge by its the toner inside may fly off and cause getting
label color (5). burned.
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Replacing Consumables and Maintenance Units

8 Remove the protective sheets.
Place a new image drum (9) on a flat
surface.

10 Insert the toner cartridge (8) taken
out in step 7 to the image drum (9) by
aligning its left side indentation (11)
with the protrusion (12) on the image
drum, and then fix the right side firmly
into place.

11 Turn the blue lever (7) of the toner
cartridge backward until its top aligns on
the A mark.

12 Check a label color of a new image drum
(9) and place the drum into a printer.

13 Close the output tray (4) by pushing the
both sides of the cover firmly.

- 103 -
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Replacing Consumables and Maintenance Units

14 Close the front cover (2).

15 Please recycle image drums.

) Replacing the Belt Unit

e The front cover cannot be closed if the output tray is
not closed securely. Life Span of Belt Unit

When the “"Belt Unit Near Life” message
appears on the display screen, prepare a
replacement belt unit. You can keep printing
approximately 1000 pages until the next
message appears.

When the “"Change Belt Unit” message
appears, replace the belt unit.

The life expectancy of the belt unit is
approximately 80,000 pages for A4 simplex
printing (three pages per job).

(1t Note)

e The actual number of pages you can print with the belt
unit depends on how you use it.

e If you must dispose of an image drum, put it in a plastic (’ N°te)
bag or similar container and dispose of it in accordance e Though opening and closing the output tray may extend
with your municipality’s ordinances or guidelines. the life of the belt unit somewhat, you should replace it
e If the light-shielding film of the image drum becomes soon aftgr the "Change Belt Unit” is displayed to prevent
malfunction.

dirty, wipe the film by following the procedures below.
e If you replace the belt unit, use it until the end of its
useable life. If you remove the belt unit and install and
(1) Open the front cover. use another one before its usable life has expired, the use
life will not be correctly displayed.

(2) Open the output tray.

e Press the scroll button ¥ or A button > [Admin Setup] >
: [System Setup] > [Near Life Status] is set to [Disable],
(3) Remove the Image drum. the [Belt Unit Near Life] message does not appear.
(4) Wipe the light-shielding film with soft

(1t Note)

e The image drum (the green tube) is very delicate. Handle
it carefully.

e Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1 Prepare a replacement belt unit.

(5) Put the image drum back to the
printer.

(6) Close the output tray by pushing the
both sides of the cover firmly.

(7) Close the front cover. 2 Turn off your printer by pressing the
power switch.
EE Reference

e “Turning Off the Power” P.21

- 104 -



Replacing Consumables and Maintenance Units

3 Insert your finger into the recess on 6 Cover the image drums you took out
the right side of the printer and pull the with paper so that the image drums do
front cover open lever (1) to open the not expose to the light.

front cover (2) forward.

7 Turn the blue locks (5) on each side of
the belt unit in direction of the arrow to
4 Press the output tray open button (3) unlock.
and open the output tray (4).

Possible to get
/\ CAUTION B, /A
e The fuser unit is extremely hot. Do not touch
it.

8 Remove the belt unit by holding the blue
lever (6).

5 Take all the four image drums out of a
printer, and then place them on a flat
surface.
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Replacing Consumables and Maintenance Units

9 Hold the handle of a new belt unit with 11 Return all the four image drums to the
one hand and support lower part with printer.
other hand. Place the belt unit into the
printer.

12 Close the output tray (4) by pushing the
both sides of the cover firmly.

10 Turn the blue locks (5) on each side of

the belt unit in direction of the arrow.
13 Close the front cover (2).

(! Note)
e The front cover cannot be closed if the output tray is
not closed securely.

14 Please recycle belt unit.

e If you must dispose of a belt unit, put it in a plastic bag or
similar container and dispose of it in accordance with your
municipality’s ordinances or guidelines.
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Replacing Consumables and Maintenance Units

Replacing the Fuser Unit

Life Span of Fuser Unit

When the “Fuser Unit Near Life” message
appears on the display screen, prepare a
replacement fuser unit. You can keep printing
approximately 1250 pages until the next
message appears.

When the “"Change Fuser Unit” message
appears, replace the fuser unit.

The life expectancy of the fuser unit is up to
100,000 pages for A4 simplex printing.

(1 Note)

e The actual number of pages you can print with the fuser
unit depends on how you use it.

(1t Note)

e Though opening and closing the output tray may extend
the life of the fuser unit somewhat, you should replace it
soon after "Change Fuser Unit” is displayed to prevent
malfunction.

e If you replace the fuser unit, use it until the end of its
useable life. If you remove the fuser unit and install and
use another one before its usable life has expired, the use
life will not be correctly displayed.

e Press the scroll button ¥ or A button > [Admin Setup] >
[Panel Setup] > [Near Life Status] is set to [Disable],
the [Fuser Unit Near Life] message does not appear.

Replacement Procedure

(t Note)

e Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1 Prepare a new fuser unit.

2 Turn off your printer by pressing the
power switch.

Reference

e “Turning Off the Power” P.21

3 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

4 Press the output tray open button (3)
and open the output tray (4).

Possible to get
burned. &

/\ CAUTION

e Since the fuser unit gets hot, carry out the
operation carefully, and when lifting it up
you must hold it by the handle. Do not try to
hold it whilst it is hot. Wait until it has cooled

down and then carry out the operation.

5 Pull forward the left locking lever (5) of
the fuser unit to unlock.
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Replacing Consumables and Maintenance Units

6 Hold the fuser unit handle (6) and lift 9 Close the output tray (4) by pushing the
the fuser unit out of the printer. both sides of the cover firmly.

10 Close the front cover (2).
(! Note)

e The front cover cannot be closed if the output tray is
not closed securely.

7 Hold the fuser unit handle (6) and place
the fuser unit into the printer.

11 Please recycle fuser unit.

e If you must dispose of a fuser unit, put it in a plastic bag
or similar container and dispose of it in accordance with
your municipality’s ordinances or guidelines.
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Cleaning

e Cleaning

This section explains how to clean each part of your printer.

Cleaning the Surface of the 2 Wipe the two paper feed rollers (2)
Printer inside the printer with a wet cloth that

has been wrung out well.

(! Note)

e Do not use benzine, thinners, or alcohol as a cleaning
agent. They may damage the plastic parts of the printer.

e Do not lubricate your printer with oil.

1 Turn off your printer by pressing the
power switch.

Reference

e "Turning Off the Power” P.21

w

2 Wipe the surface of the printer with a Remove paper loaded in the tray.

soft cloth lightly moistened with water or
neutral detergent.

N

Wipe the paper feed roller (3) on the
tray with a wet cloth that has been

3 Dry the surface of the printer with a dry wrung out well.

soft cloth.

Cleaning Paper Feed Rollers

Clean the paper feed rollers if paper jams occur
frequently.

(1t Note)

e You should replace the paper feed rollers if paper jams
keep occurring even after cleaning the paper feed rollers.

5 Load paper in the tray.
For Tray 1/2/3/4

e This procedure images use tray 1 as an example, but the
same procedure applies to tray 2/3/4. For MP Tray

6 Push the tray back into the printer.

1 Pull out the tray (1). 1 Open the MP tray (1) forward by
inserting your fingers into the front
recesses (2).
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Cleaning

2

4 Open the paper set cover (5) until

Release the tab (3) of the paper feed 5 Wipe the two paper feed rollers (6) with
roller cover by pressing the right arm (4) a wet cloth that has been wrung out
inward while lifting up the MP tray (1) well.

lightly.

Open the separation roller cover (7)

Also press the left arm (4) inward while forward while pressing the center part of
lifting up the MP tray (1) lightly to the MP tray. pressing P
release the tab (3) of the paper feed Wipe the two separation roller (8) with a
roller cover. wet cloth that has been wrung out well.

touching the printer.
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Cleaning

9 Hook one tab (3) of the paper feed roller Cleaning LED Heads

cover by pressing the right arm (4)
inward while lifting up the MP tray (1)

Clean the LED heads if vertical lines appear,

lightly. images are fading vertically, or the periphery of
(1t Note) letters is smudged in the printouts. Dirt on the
e If closing the MP tray without returning the tab to the LED heads may also cause paper jams.

correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.

10 Also hook the other tab (3) of the paper

feed roller cover by pressing the left arm

(4) inward while lifting up the MP tray
(1) lightly.
(! Note)

e If closing the MP tray without returning the tab to th
correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.

11 Close the MP tray (1).

If the MP tray cannot be closed, return the paper
set cover to the correct position by pressing the
paper loading part on the MP tray downward.

(1t Note)

e Do not use methyl alcohol or thinners as a cleaning agent.
They may damage the LED heads.

e Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1 Turn off your printer by pressing the
power switch.

Reference

e “Turning Off the Power” P.21

2 Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

e

3 Press the output tray open button (3)
and open the output tray (4).

& CAUTION Possible to get &

burned.

e The fuser unit is extremely hot. Do not touch

it.
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4 Lightly wipe the lenses (5) of the LED
heads with soft tissue paper.

5 Close the output tray (4) by pushing the
both sides of the cover firmly.

6 Close the front cover (2).

(! Note)
e The front cover cannot be closed if the output tray is
not closed securely.
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Moving or Transporting Your Printer

e Moving or Transporting Your Printer

This section explains how to move or transport your printer.

Moving Your Printer

It may cause
injury. A

/\ CAUTION

e At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

1 Turn off your printer by pressing the
power switch.

Reference

e “Turning Off the Power” P.21

2 Unplug all the cables.
e AC cord and ground wire
e Ethernet or USB cable

3 Remove any paper from the paper trays.

4 Lift your printer and move it to a new
location.

Transporting Your Printer

It may cause
injury. A

/\ CAUTION

e At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

Possible to get
/\ CAUTION vy /A
e The fuser unit is extremely hot. Do not touch
it.
(! Note)

e The image drum (the green tube) is very delicate. Handle
it carefully.

e Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1 Turn off your printer by pressing the
power switch.

Reference

e “Turning Off the Power” P.21

2 Unplug all the cables.
e AC cord and ground wire.
e Ethernet or USB cable.

w

Remove any paper from the paper trays.

N

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

5 Press the output tray open button (3)
and open the output tray (4).

Possible to get &

A CAUTION burned.

e The fuser unit is extremely hot. Do not touch

it.
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Moving or Transporting Your Printer

6 Hold the toner cartridges with both
hands and remove them with the image
drums. Remove all the toner cartridges
and image drums, and place them on a
flat surface.

7 Secure each toner cartridge to each
image drum with vinyl tape (5).

8 Return all the toner cartridges and
image drums to the printer.

10

Close the output tray (4) by pushing the
both sides of the cover firmly.

Close the front cover (2).

(! Note)
e The front cover cannot be closed if the output tray is
not closed securely.

11 Remove the optional additional tray unit
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Moving or Transporting Your Printer

12 Protect your printer with packing
materials.

13 Lift your printer and put it in a box.

C! Note)

e Use the packing materials attached to your printer when
purchased.

e After transporting or when setting up again, remove
the vinyl tape used to secure the image drum and toner
cartridges.
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5. Appendix

This chapter explains the specifications of your printer.

e Specifications

Model Model Number
C823/C833/ES8433 |N35100A, N35100B
C843/ES8443 N35101A, N35101B

B General Specifications

Voltage 220 - 240 VAC : Less than 0.15 W

C823 | «c833/ES8433 | c843/ES8443
CPU PowerPC464FP, 800 MHz
Memory Resident 256 MB
Option 256 MB/512 MB
Flash ROM System Memory : 128MB
Storage Device SD memory card kit
e Optional
16 GB
Weight 37 Kg (including consumables without a duplex unit),
40 Kg (including consumables with a duplex unit)
Dimensions 449(W) x 552(D) x 360(H) mm
Power supply N35100A, N35101A :
110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz £ 2%
N35100B, N35101B :
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz £ 2%
Power Typical 700 W
consumption |operation
Idle 100 W
Peak 1400 W
Deep sleep Voltage 110 - 127 VAC : Less than 0.7 W
mode Voltage 220 - 240 VAC : Less than 1.0W
Power save Less than 12 W
mode
Off mode Voltage 110 - 127 VAC : Less than 0.1 W

Interface

USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX/1000BASE-TX

Display

Graphics panel 60(W) x 32.6(H) mm, 128 x 64 dots

Supported OS

e Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista, Windows
Server 2012 R2, Windows Server 2012, Windows Server 2008 R2, Windows

Server 2008
e Mac OS X 10.8.5-10.11
Please refer to product requirements for details.
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Specifications

®m Printing Specifications

C823 | c833/ES8433 | (C843/ES8443

Printing method

Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation language

PCL6 (XL3.0 and PCL5c) PCL6 (XL3.0 and PCL5c), PostScript 3

Resident fonts

PCL: 91 european fonts PCL: 91 european fonts
PS: 80 european fonts

Resolution

1200 x 1200 dpi, 600 x
600 dpi

600 x 600 dpi, 600 x 1200 dpi, 600 x 600 dpi 2bit

Color

Yellow, Magenta, Cyan, Black

Print speed (A4)

Simplex: 23 ppm Simplex: 35 ppm
Duplex: 19 ppm Duplex: 27 ppm

Paper size Tray 1

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B5, B4, A6, B6,
Statement, 8.55Q, Folio, custom size, 8K (260 x 368 mm, 270 x 390 mm, 273 X
394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm)

Tray 2/3/4
(Option)*

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8.55Q, Folio,
custom size, 8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273
mm, 195 x 270 mm, 184 x 260 mm)

MP Tray

Legal 13/13.5/14, letter, executive, tabloid, statement, A3, A4, A5, B4, B5, A6,
B6, B6 Half, Statement, 8.55Q, Folio, 4x6inch, 5x7inch, Nagagata #3, Nagagata
#4, Nagagata #40, Youkei #0, Youkei #4, Kakugata #2, Kakugata #3, Hagaki,
Oufuku Hagaki, C4, C5, DL, Com-10, index card (3 x 5 inch), custom size, 8K
(260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270
mm, 184 x 260 mm)

Duplex
Printing

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, B6, 8.55Q, Folio,
8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x
270 mm, 184 x 260 mm), custom size (148 - 297 mm (W) x 182 - 431.8 mm (L)),
B6, 8.55Q, Folio

Custom size

e Tray 1

105, 128 - 297 mm (W),
(4.1, 5.0 - 11.7 inches (W),
e Tray 2/3/4 (option)*

148 - 297 mm (W),

(5.8 - 11.7 inches (W)

e MP tray

64, 128 - 297 mm (W), 90, 182 mm - 1312, 431.8 mm (L)
(2.5, 5.0 - 11.7 iinches (W), 3.5, 7.2 inches - 52.0, 17.0 inches (L))

148, 182 - 431.8 mm (L)
5.8, 7.2 - 17.0 inches (L))

182 - 431.8mm (L)
7.2 - 17.0 inches (L))

Media type

Plain paper (64 g/m? - 256 g/m?), letterhead, transparency, label, bond, recycle,
card stock, rough, glossy

Feeding method

Automatic feeding from the tray 1, MP tray and additional tray unit (optional),
Manual feeding from MP tray

Paper loading capacity

e Tray 1

300 sheets of Standard paper /80 g/m?, total thickness 30 mm or lower.
e MP tray

100 sheets of Standard paper /80 g/m? and total thickness 10 mm or lower, 10

envelopes/ weight of 85 g/m?.
e Additional tray unit (optional)

530 sheets of Standard paper /80 g/m?, total thickness 53 mm or lower.

Output method

Face up/Face down

Paper output capacity

e Face up

100 sheets (less than 80 g/m?), 10 sheets (ultra-heavy/envelopes)
e Face down

200 sheets (less than 80 g/m?)

Print guaranteed area

6.35 mm or more from the paper edge (not applicable to special media such as
envelopes)

Print precision

Print beginning:+ 2 mm, paper skew:+ 1 mm/100 mm,

image expansion:£ 1 mm/100 mm (80 g/m?)
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Specifications

C823 | «c833/ESs8433 | C843/ES8443

Warm-up time

e From power on

32 seconds (at room temperature 25°C, rated voltage)
e From power save mode

27 seconds (at room temperature 25°C, rated voltage)

Operating environment

e When in operation

10 - 32°C / Relative Humidity of 20 - 80% (maximum wet bulb temperature of
25°C, maximum dry bulb temperature of 2°C)

e When not in operation

0 - 43°C / Relative Humidity of 10 - 90% (maximum wet bulb temperature of
26.8°C, maximum dry bulb temperature of 2°C)

Conditions for the guarantee
of print quality

e Operating Range

Temperature 10°C, humidity 20 to 80% RH
Temperature 32°C, humidity 20 to 60% RH
Humidity 20% RH, temperature 10 to 32°C
Humidity 80% RH, temperature 10 to 27°C

e Full-color Print Quality Assured Range
Temperature 17 to 27°C, humidity 50 to 70% RH

Consumables, Maintenance
Unit

Toner cartridges, image drum, belt unit, fuser unit, feed roller set

*(C823 is available only Tray2.

B Network Specifications

Cc823 | c833/ES8433 | (C843/ES8443
Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-TX
Protocol TCP/IPv4, TCP/IPv6, SMTP, POP3, HTTP, SNMPv1/v3, DHCP, DNS, LPR, Port9100,

BOOTP, ARP, FTP, Bonjour (Rendezvous), Web Services Discovery (WSD)

Supported browsers

Microsoft IE 6.0 or later, Safari 3 or later, Firefox 3.0 or later
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Specifications

|| Wireless LAN Specifications (Option)

Item
Wireless LAN standard IEEE802.11a/b/g/n conformity (2.4 GHz / 5 GHz)

Security Disable, WEP, WPA-PSK, WPA2-PSK, WPA-EAP, WPA2-EAP

Regulatory wireless LAN statements

- FCC Statement

- IC Statement

- Europe-CE Declaration of conformity.
FCC statement

FCC WARNING

Changes or modifications not expressly approved by the party responsible for compliance could void
the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio

or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.
IC statement

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s).
Operation is subject to the following two conditions: (1) this device may not cause interference, and
(2) this device must accept any interference, including interference that may cause undesired operation
of this device.

Le présent appareil est conforme aux la partie 15 des régles de la FCC et CNR d’Ubdustrie Canada
applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions
suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d’en compromettre
le fonctionnement.

This Class [B] digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe [B] est conforme a la norme NMB-003 du Canada.
Caution (FCC/IC):

5.15-5.25 GHz band is restricted to indoor operations only.

La bande 5150-5250 MHz est restreints a une utilisation a l'intérieur.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled
environment and meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment should be installed and operated keeping the radiator at
least 20 cm or more away from person’s body.
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Specifications

Cet équipement est conforme aux limites d’exposition aux rayonnements énoncées pour un
environnement non controlé et respecte les régles les radioélectriques (RF) de la FCC lignes directrices
d’exposition et d’exposition aux fréquences radioélectriques (RF) CNR-102 de I'IC. Cet équipement
doit étre installé et utilisé en gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le
corps.

Europe - CE Declaration of Conformity

430,

This equipment complies with the essential requirements of the European Union directive 1999/5/EC.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France,
Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg,
Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, Turkey and United Kingdom.
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B Printer Dimensions

™ 449 mm

Specifications

TOP VIEW

@

| | Qe
()
nf
SIDE VIEW
1107 mm
255 mm 552 mm
A
420 mm

Y

400 mm

360 mm

OPTION-INSTALLED VIEW (TRAY2/3/4)

760 mm

498 mm

774 mm
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Oki contact details

Oki Systems (UK) Ltd

Blays House
Wick Road
Egham
Surrey
TW20 OHJ

Tel: +44 (0) 1784 274300
Fax: +44 (0) 1784 274301
http://www.oki.co.uk

Oki Systems Ireland Limited

The Square Industrial Complex
Tallaght
Dublin 24

Tel: +353 (0) 1 4049590
Fax: +353 (0)1 4049591
http://www.oki.ie

Oki Systems Ireland Limited -
Northern Ireland

19 Ferndale Avenue
Glengormley

BT36 5AL

Northern Ireland

Tel: +44 (0) 7767 271447
Fax: +44 (0) 1 404 9520
http://www.oki.ie

Technical Support for all Ireland:
Tel: +353 1 4049570

Fax: +353 1 4049555

E-mail: tech.support@oki.ie

OKI Systems (Czech and Slo-
vak), s.r.o.

Futurama Business Park -
Sokolovska 651/136A
186 00 Praha 8

Czech Republic

Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland)
GmbH

Hansaallee 187
40549 Duisseldorf

Tel: +49 (0) 211 / 5266-0
Fax: +49 (0) 211 59 33 45
Website: www.oki.deinfo@oki.de

Albania, Bosnia, Bulgaria, Croatia,
Cyprus, Estonia, Greece, Israel,
Latvia, Lithuania, Macedonia,
Romania, Serbia, Slovenia

CEE Export Group: OKI Systems
(Poland) Ltd

ul. Domaniewska 42
02-672 Warsaw
Poland

Tel: +48 (0) 22 448 65 00
Fax: +48 (0) 22 448 65 0
E-mail: tech@oki.com.pl

Oki Systemes (France) S.A.

Zone Silic - Immeuble Osaka
21 rue du Jura

CS 90277

94633 RUNGIS Cedex

Paris

Tél: Standard 0820 200 410
(0.09€/min depuis une ligne fixe*)
Hotline 01 76 54 21 50 (n° non
surtaxé)

Website: www.oki.fr

OfKI Systems (Magyarorszag)
Kft.

Capital Square

Tower 2

7th Floor

H-1133 Budapest,

Vaci ut 76

Hungary

Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.

via Milano, 11,
20084 Lacchiarella (MI)

Tel: +39 (0) 2 900261
Fax: +39 (0) 2 90026344
Website: www.oki.it

OKI Systems (Polska) Sp. z 0.0

Platinium Business Park II, 3rd
Floor

ul. Domaniewska 42

02-672 Warsaw

Poland

Tel: +48 22 448 65 00
Fax: +48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

OKI Europe Limited, Sucursal
em Portugal

Av. Quinta Grande 53
70 D Alfragide
2614-521 Amadora
Portugal

Tel: +351 21 470 4200
Fax: +351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service )
Servigo de apoio técnico ao
Cliente

Tel: 214 727 660
E-mail : okiserv@oki.pt
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OKI Systems Rus, LLC (Russia)

Sector B, 3rd Floor, Svyatogor-4
Business Center10/4, Letnikovskaya
str.115114, Moscow

Tel: +7 495 276 5060
Fax: +7 495 258 6070
e-mail: info@oki.ru
Website: www.oki.ru

Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Osterreich)

Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge

Tel: +43 223 6677 110
Service-Hotline:

+43 (0) 2236/677 110-501
Website: www.oki.at

OKI Europe Ltd. (Ukraine)

Raisy Opkinoy Street,8
Building B, 2"d Floor,
Kiev 02002

Ukraine

Tel: +380 44 537 5288
e-mail: event@oki.ua
Website: www.oki.ua

OKI Sistem ve Yazici Coziimleri
Tic. Ltd. Sti.

Harman sok Duran Is Merkezi,
No:4, Kat:6,

34394, Levent

Istanbul

Tel: 490 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr

Oki Systems (Belgium)

Medialaan 24
1800 Vilvoorde

Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

OKI Systems (Danmark) a-s

Herstedgstervej 27
2620 Albertslund
Danmark

Adm.: +45 43 66 65 00
Fax: +45 43 66 65 90
E-mail: salg@oki.dk /
support@oki.dk
Website: www.oki.dk



Oki Systems (Finland) Oy

Polaris Capella
Vanrikinkuja 3
02600 Espoo

Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809
Website: www.oki.fi

Oki Systems (Holland) b.v.

Neptunustraat 27-29
2132 JA Hoofddorp

Helpdesk: 0800 5667654
Tel: +31 (0) 23 55 63 740
Fax: +31 (0) 23 55 63 750
Website: www.oki.nl

Oki Systems (Norway) AS

Tevlingveien 23
N-1081 Oslo

Tel: +47 (0) 63 89 36 00
Telefax: +47 (0) 63 89 36 01
Website: www.oki.no

Var vanlig kontakta din
Aterforsaljare i forsta hand, for
konsultation. I andra hand kontakta

Oki Systems (Sweden) AB

Borgafjordsgatan 7
Box 1193
164 26 Kista

Tel. +46 (0) 8 634 37 00
e-mail: info@oki.se
Website: www.oki.se

Oki Systems (Schweiz)

Baslerstrasse 15
CH-4310 Rheinfelden

Support deutsch +41 61 827 94 81
Support francgais +41 61 827 94 82
Support italiano +41 061 827 9473

Tel: +41 61 827 9494
Website: www.oki.ch

Oki Data Americas Inc.(United
States e Etats-Unis)

2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel: 1-800-654-3282

Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.COM
http://my.okidata.com

Oki Data Americas Inc.(Canada
e Canada)

4140B Sladeview Crescent Unit 7 & 8
Mississauga, Ontario

Canada L5L 6A1

Tél: 1-905-608-5000

Téléc: 1-905-608-5040
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data Americas Inc.(América
Latina (OTRO))

2000 Bishops Gate Blvd.

Mt. Laurel, NJ 08054

USA

Tel (Espafiol): 1-856-222-7496
1-856-222-5276

Fax: 1-856-222-5260

Email: LASatisfaction@okidata.com

Oki Data de Mexico, S.A. de C.V.

Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.

Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data do Brasil Informatica
Ltda.

Av. Alfredo Egidio de Souza Aranha,
100 - 59 Andar - Bloco C

Chacara Santo Antonio - Sdo Paulo,
SP - Brasil

CEP: 04726-170

Tel: 55-11-3543-5500

Fax: 55-11-3444-3501

email: okidata@okidata.com.br
HTTP://www.okiprintingsolutions.com

Argentina/Chile/Paraguay/Pera/
Uruguay
Oki Data Americas, Inc.

Sucursal Argentina
Ugarte 3610 Piso 4°(1605) Olivos
Buenos Aires, Argentina

TEL: +54 11 5288 7500
Fax: +54 11 5288 7599
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Colombia/Ecuador/Venezuela/
Centroamérica y Caribe
Oki Data Americas, Inc.

Sucursal Colombia
Carrera 13 #97-51, Oficina 101
Bogotd Colombia

TEL: +57 1 704 5159

Oki Data (Singapore) Pte. Ltd.

438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)

Tel: (65) 6221 3722

Fax: (65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.

1168/81-82 Lumpini Tower,
27th Floor Rama IV Road
Tungmahamek, Sathorn
Bangkok 10120

Tel: (662) 679 9235
Fax: (662) 679 9243/245
http://www.okisysthai.com

Oki Data(Australia) Pty Ltd.

Levell 67 Epping Road, Macquarie
Park
NSW 2113, Australia

Tel: +61 2 8071 0000
(Support Tel: 1800 807 472)
Fax: +61 2 8071 0010
http://www.oki.com.au

OKI Data New Zealand

8 Antares Place Rosedale,
Auckland, 0632 New Zealand

Tel: (64) 9 477 0500
Fax: (64) 9 477 0549
http://www.oki.co.nz/

Oki Data(S) P Ltd. Malaysia Rep Office

Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,

Lingkaran Syed Pura 59200,

Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166



Oki Data Corporation

4-11-22 Shibaura, Minato-ku, Tokyo
108-8551, Japan

www.oki.com/printing/
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